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1 Hinweise

In dieser Anleitung ist die Installation unter Windows Vista beschrieben. Die Installation unter Windows
2000, XP sowie unter Windows 7 und Windows 8 erfolgt entsprechend.

Beachten Sie bitte, dass Windows zum Installieren von Treibern zwingend Administratorrechte
verlangt! Bitte erkundigen Sie sich bei lhrem Administrator, wenn Sie liber diese nicht verfiigen!

1.1 Lizenzbedingungen fir diese Software

Die Urheberrechte dieser Software liegen bei:

tecsis GmbH
Carl-Legien-Str. 40-44
63073 Offenbach

Deutschland

Die Lizenzbedingungen werden wahrend der Installation der Software angezeigt. Wenn die
Lizenzbedingungen nicht akzeptiert werden, wird die Installation abgebrochen. Die Lizenzbedingungen
kénnen nach der Installation in der Software im Men( ,Hilfe > Hinweis’ angezeigt werden.

1.2 BestimmungsgemaBe Verwendung

Die VASUSB dient zum Einstellen, Steuern und Auslesen des EZE21 oder des EZE22. Weitere
Funktionen der VASUSB sind das Empfangen, Darstellen und Speichern von Messwerten. Jede darlber
hinausgehende Verwendung gilt als nicht bestimmungsgemas.

1.3 Kennzeichnung der Hinweise

Sollten Restgefahren beim Arbeiten mit der VASUSB auftreten, wird in dieser Anleitung mit folgenden
Symbolen darauf hingewiesen:

@ Hinweis:
Wichtige zu beachtende Punkte

1.4 Systemvoraussetzungen

Fir den Betrieb der VASUSB benétigen Sie einen PC mit folgenden Systemvoraussetzungen.
e  Windows 2000, Windows XP, Windows Vista, Windows 7 oder Windows 8
e Fir EZE22 bzw. EZE21: eine USB-Schnittstelle
e bis zu zwei Monitore werden unterstitzt

Empfohlene Anforderungen an Hardware:
e Anwendung ausfiihren ohne Diagramm: Single-Core ab 2,0 GHz
e Anwendung ausfihren mit Diagramm: Dual-Core ab 1,8 GHz
e Je héher die Messrate und je langer eine Messung dauert sollte der Hauptspeicher entsprechend
gréBer ausgelegt sein. Die Anwendung beendet eine Messung, sobald das System keinen freien
Hauptspeicher mehr zur Verflgung stellen kann. Die absolute GrdBe des benutzten
Hauptspeichers héngt ab vom Betriebssystem und zusétzlichen installierten Komponenten.

www.tecsis.de BD_BE 936 _EZE21 5
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2 Einleitung
2.1 Produktbeschreibung

Diese Bedienungsanleitung beschreibt die Eigenschaften und Bedienungsablaufe fur die VASUSB.

2.2

Aufbau der Software

Die VASUSB besteht aus folgenden Bestandteilen:

2.3

Konfigurationsmdglichkeiten flr die VASUSB

Speichern sensorbezogener Skalier- und Einstellungsdaten

Anzeige zur Darstellung der Messdaten (aktueller Messwert, Tarierwert, Minimalwert und
Maximalwert)

Darstellung der Messdaten im Diagramm

Anzeige und Speicherung von Bewertungen von Messdaten

Speichern der Messdaten im CSV Format (Ausgabe konfigurierbar)

Speichern des Diagramms im BMP Format (AusgabegréB3e einstellbar)

Drucken des Diagramms (AusgabegrdBe definiert)

Darstellung der Sensorinformationen

Sicherer und korrekter Gebrauch

@ Achten Sie auf eine korrekte Sensorjustierung.
@ Achten Sie auf die korrekte Konfiguration der VASUSB.
@ Wabhlen Sie beim Speichern der Messdaten aussagekréaftige Dateibezeichnungen/Préfixe.

3

Die Software startet nur, wenn sie einen kompatiblen Sensor' am USB Anschluss identifiziert. Nach dem
Starten der ausfiihrbaren Datei erscheint die Suche nach einem kompatiblem USB Sensor'. Ist die Suche
nicht erfolgreich, tberprifen Sie bitte, ob die USB Leitung am Sensor und am PC verbunden ist und dass
die USB Treiber installiert sind. Klicken Sie anschlieBend auf ,Nochmals suchen’ um erneut nach einem
kompatiblen Sensor zu suchen. Wird ein kompatibler Sensor gefunden, so werden die sensorbezogenen

Starten der Software

Daten automatisch ausgelesen.

! Kompatible Sensoren: EZE21, EZE22

6

BD_ BE 936 VASUSB www.tecsis.de



Bedienungsanleitung/Operating manual
VASUSB

4 Beschreibung der Funktionsweise

Die Software besteht aus einer Menlleiste, einer Navigierleiste, einer Statusleiste und einem
Arbeitsbereich. Die Funktionen der Mendlleiste entsprechen denen der Navigierleiste. Die digitalen
Messwertanzeigen der physikalischen Gré3en, der Bewertungsanzeige und das Diagramm sind nur unter
,Betriebsart > Mess- und Diagrammmodus’ sichtbar. Im Arbeitsbereich werden die unter ,Betriebsart’
zusammengefassten Dialoge angezeigt.

o Konfigurationsmodus (siehe Kapitel 4.2)

¢ Mess- und Diagrammmodus (siehe Kapitel 4.3)
Das Umschalten zwischen den Dialogen kann Uber die Navigierleiste sowie Uber die gleichgestellte
Mendleiste erfolgen. Einstellungsanderungen im Dialog werden ohne eine Bestdtigung tUbernommen.
Sémtliche Einstellungen werden beim Beenden der Anwendung abgespeichert und beim erneuten
Starten der Anwendung wieder geladen.
Die Statusleiste stellt aktuelle Zustandsinformationen der Anwendung dar.

e Betriebsbereit. Sensor verbunden’

e ,Sensor getrennt’

e ,Messen..’

e ,warten auf Triggerstart-Ereignis’

e Messen! Warten auf Triggerstopp-Ereignis’
AuBerdem werden Informationen Uber die Steuerelemente aus der Menii- und Navigierleiste sowie der
Fortschritt der Speicherung in eine CSV-Datei in der Statusleiste ausgegeben.

4.1 Die Menileiste/Navigierleiste des Programms

411 Datei = Speichern Messwerte (Tastenkombination ,Strg+M’)

Von hier aus werden Messdaten der letzten Messung® in eine CSV - Datei abgespeichert. Das
Ausgabeformat der Datei ist im Dialog ,Betriebsart > Konfigurationsmodus - Dokumentation’ unter
der Uberschrift ,Ausgabe Messwerte’ einstellbar (siehe Kapitel 4.2.4.1
,Documentation > Output Measured Values’). In der ersten Spalte der
CSV - Datei sind die Messwerte aufsteigend nummeriert. Die Ausgabe
der Spalte zwei bis maximal drei wird von der Einstellung unter
,Betriebsart > Konfigurationsmodus -> Messeinstellungen’ unter
der Uberschrift ,Diagramm’ Ubernommen. Jede hier eingestellte
physikalische GréBe wird in die Datei geschrieben. Die Reihenfolge
hierbei ist: [X-Achse], [Y1-Achse], [Y2-Achse].

Uberschrift:
Messung 1.4

Adresse:

Lorenz Messtechnik GmbH
Obere SchlossstraBe 131
73553 Alfdorf

Bemerkung:
Dipl. Ing. K. Mustermann

Messinformationen:

Achtung: Samtliche Ausgabeeinstellungen sind vor

Beginn einer Messung zu tatigen.

Achtung: Eine CSV-Datei ist eine Textdatei zur
Speicherung von einfach strukturierten Daten. Das
Kirzel CSV steht dabei fir ,Character Separated
Values” oder ,Comma Separated Values”. Die Werte
sind durch spezielle Trennzeichen, beispielsweise
durch ein Komma oder Semikolon voneinander
getrennt. Eine CSV-Datei kann durch Doppelklick mit
Excel® gedffnet werden (bei Windows Excel® 2007
Import Uber Daten - ,aus Text").

Die Bedeutung von Listen-Feld- und Zeilen-
Endzeichen sind nicht einheitlich festgelegt. Eventuell
mussen die Definitionen unter 4.2.4.1 Documentation
- Output Measured Values - ,Zeilenendzeichen’ /
,Spaltentrennzeichen’ / ,Dezimaltrennzeichen’ in
der VASUSB oder in lhrer Tabellenkalkulation
eingestellt werden. Bitte ziehen Sie hierzu die
Anleitung Ihrer Tabellenkalkulation zu Rate.

Sensor: S|-USB

Sensortyp:
Seriennummer:

Seriennummer (Kanal):

Messbereichsendwert:
Genauigkeitsklasse:
Messunsicherheit:

Messrate:
gleitender Mittelwert:

DMS
2009

123456

A12345

DMS

0,10%

n.a.

2500/sek

512

Drehmoment

B12345
1,00 kN-m
0,10%
0,01%

128

Reduzierung der Messrate mit Mittelung tiber 125 Werte.

Werksjustierung:
Benutzerjustierung:

Start (Datum Uhrzeit):

07.05.2006 inaktiv
25.09.2009 aktiv

28.09.2009

08:20:02 Uhr

# Kanal A (mV/V)  Kanal B (kN-m)

0 0,000 mv/v
10,000 mv/v
20,000 mV/V
3 0,000 MV/V
4/0,000 mV/v
50,000 mV/V
& 0,000 mV/V
70,000 mv/v
8 0,000 mV/V
9 0,000 mV/V
10 0,000 mV/V

-1,6384 kN-m
-1,6384 kN-m
-1,6384 kN-m
-1,6384 kN-m
-1,6384 kN-m
-1,6384 kN-m
-1,6384 kN-m
-1,6384 kN-m
-1,6384 kN-m
-1,6384 kN-m
-1,6384 kN-m

2 Messung: Aufnahme einer Reihe Messwerte in der konfigurierten Messrate von Start [...] bis Stopp [...]

www.tecsis.de
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4.1.2 Datei = Speichern Diagramm (Tastenkombination ,Strg+D’)

Von hier aus kdnnen Messdaten der letzten Messung? in eine BMP - Datei abgespeichert werden.
Es konnen vordefinierte AusgabegréBen in ,Betriebsart - Konfigurationsmodus > Dokumentation’
unter der Uberschrift ,Ausgabe Diagramm’ in der Box ,SpeichergroBe’ eingestellt werden. Hierbei gibt
es folgende Méglichkeiten:
e max:
Einstellung ist nur vorhanden wenn das Betriebssystem zwei Bildschirme erkennt. Auf diesen
beiden Bildschirmen wird gréBtmdglich das Diagramm aufgespannt und abgespeichert.

e normal:

Das Diagramm wird ca. auf der GréBe des Bildschirms aufgespannt und abgespeichert.
e min:

Das Diagramm wird ca. auf 800x600 Pixel des Bildschirms aufgespannt und abgespeichert.
e Fenster:

Das Diagramm wird wie vom Benutzer in der Anwendung eingestellt abgespeichert.
Es kann ein gewlnschter Bereich der Messung mit Hilfe des Bereichsschiebers und des
Intervallschiebers ausgewahlt werden.

Diagramm =]
) - Bereichsschieber

2000 | 1,000
4000 0 5000 ﬂ
0000

“anno | 15000 {3258

1,000 1??%;? 1600 2000 ZoT > |nterva||schieber

Das Diagramm verfiigt Uber ein Kontextmen(. Dieses ist mit einem Rechtsklick mit der Maus auf das
Diagramm mit folgenden Funktionen erreichbar:
e Zoomin:
Mauszeiger wird zu einem Kreuz. Mit Halten der linken Maustaste im Diagramm und Ziehen der
Maus wird ein Rechteck aufgespannt in das beim Loslassen der Maustaste hinein gezoomt wird.
e Zoom out:
Das Diagramm gibt den vollstéandigen Bereich der letzten Messung an.
e Verschieben:
Mauszeiger wird zum Kreuz mit Pfeilen. Mit Halten der linken Maustaste im Diagramm kann die
Kurve versetzt/verschoben werden.
e Raster ein/aus:
Das Raster sind die Strichlinien im Diagramm. Diese kdnnen mit dieser Funktion ein-/ bzw.
ausgeblendet werden.
e Legende anzeigen:
Die Legende gibt die physikalischen GréBen und deren Einheit wieder. Diese kann mit dieser
Funktion ein-/ bzw. ausgeblendet werden.

@ Achtung: Beim Speichern des Diagrammes wird nur der aktuell dargestellte Teil der Messung
abgespeichert.

8 BD_ BE 936 VASUSB www.tecsis.de
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41.3 Datei > Drucken (Tastenkombination ,Strg+P’)

Mit Hilfe dieser Funktion kann ein Ausdruck des Diagramms mit Druckzeitpunkt, konfigurierbarer
Uberschrift, konfigurierbarer Bemerkung, konfigurierbarer Adresse sowie kundenspezifischem Logo
erstellt werden (siehe Bild rechts).
Der Anwender kann die Konfiguration mit dem Navigierleistenelement ,Dokumentation® vornehmen?®.
Zeilenumbriche in Bemerkung und Adresse werden in Leerzeichen umgewandelt.
Es gelten die folgenden Beschrankungen

o die Uberschrift wird auf 20 Zeichen begrenzt

e die Bemerkung wird auf 57 Zeichen begrenzt

o die Adresse wird auf 82 Zeichen begrenzt

Um ein kundenspezifisches Logo einzubinden muss dieses unter dem Dateinamen
»,Custom_Print_Logo.bmp*“ gespeichert und in den Ordner ,%USERPROFILE%\AppData\Local\tecsis"
kopiert werden”.

@ Achtung: Die empfohlenen Eigenschaften der Bitmap ,Custom_Print_Logo.bmp* sind:
e 160 Pixel *160 Pixel
¢ Maximale Bittiefe: 32bit

Wenn sich keine Datei mit Namen ,,Custom_Print_Logo.bmp* im Ordner
»,<ZJoUSERPROFILE%\AppData\Local\tecsis* befindet, dann wird das tecsis Logo eingebunden.

41.4 Datei > Beenden (Tastenkombination ,Strg+E’)

Beendet das Programm. Wenn das Programm beim Beenden noch im Messen ist, so wird die Messung
beendet. Ist eine automatische Speicherung (siehe Kapitel 4.2.4.1 Documentation - Output Measured
Values und Kapitel 4.2.4.2 Dokumentation - Ausgabe Diagramm) eingestellt, wird diese noch
ausgefihrt, bevor das Programm endgiltig beendet wird.

4.1.5 Betriebsart

Unter diesem Uberbegriff sind alle Sensorbezogenen Einstellungen ,Konfigurationsmodus’ zu finden
sowie auch der ,Mess- und Diagrammmodus’. Mit der Auswahl eines Modus wird dieser im
Arbeitsbereich dargestellt. Folgende Dialoge kébnnen Angezeigt werden:

¢ Konfigurationsmodus = Sensorverbindung (siehe Kapitel 4.2.1)
Konfigurationsmodus - Sensorinformation (siehe Kapitel 4.2.2)
Konfigurationsmodus > Messeinstellungen (siehe Kapitel 4.2.3)
Konfigurationsmodus = Dokumentation (siehe Kapitel 4.2.4)
Konfigurationsmodus = Sensorjustierung (siehe Kapitel 4.2.5)

e Mess- und Diagrammmodus (siehe Kapitel 4.3)
Nach einem erneuten Starten der Software wird diese mit dem zuletzt aktiven Dialog gestartet. Mit der
Tastenkombination ,Strg+TAB’ kann zum nachsten Menl gesprungen werden und mit der Tasten-
kombination ,Strg+Umschalttaste+TAB’ zum vorherigen.

4.1.6 Ansicht

Die Steuerelemente unter ,Ansicht’ sind fir das Ein-/ bzw. Ausblenden von Leisten und Anzeigen sowie
das Zuriicksetzen der Fensteransicht zusténdig. In der MenUleiste/Navigierleiste wird ein Haken fiir ein-

% siehe Kapitel 4.2.4
* Die Umgebungsvariable %USERPROFILE% speichert den aktuellen Windows® Pfad des
angemeldeten Benutzers.
Dieser Pfad wird wahrend der Installation von Windows® festgelegt und kann in der
Systemsteuerung und Uber Gruppenrichtlinien verandert werden.
Auch der Anmeldename geht in den Pfad mit ein.
Per Default lautet dieser Pfad unter Windows® 7 (deutsch):
C:\Users\<Username> ( »Computer » Lokaler Datentrager » Benutzer » <Benutzername> )

www.tecsis.de BD_BE 936 _EZE21 9
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geblendete Leisten oder Anzeigen angezeigt. Die digitalen Anzeigen sowie das Diagramm kénnen nur im
Mess- und Diagrammmodus umgeschaltet werden, andernfalls sind diese ausgegraut (deaktiviert). Beim
Ausfihren von ,Ansicht 2> Ansicht zuriicksetzen’ (z.B. mit der Tastenkombination ,Strg+R‘) werden die
digitalen Anzeigen, das Diagramm und das Hauptfenster in den Ursprungszustand zurlickversetzt.

41.7 Sprache

Hier kann die Sprache der VASUSB eingestellt werden. Alle Bezeichnungen der Anwendung werden
entsprechend der ausgewahlten Sprache umgestellt.
Folgende Sprachen werden unterstltzt:
e Deutsch
e Englisch
e Franzosisch
Beim Neustart der Software bleibt die zuletzt eingestellte Sprache bestehen.

4.1.8 Hilfe - Info

Hier ist die Software Versionsnummer hinterlegt.

41.9 Hilfe & Hinweis

Beinhaltet die Lizenzbedingungen fiir diese Software. AuBerdem befindet sich darin die Anschrift sowie
Links zur Homepage und Kontakt-E-Mail Adresse.

10 BD_ BE 936 VASUSB www.tecsis.de
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4.2 Konfigurationsmodus

Der Konfigurationsmodus umfasst samtliche Sensor-, Mess- und Dokumentationseinstellungen, sowie die
Einstellungen der Ausgabe von Sensorinformationen. Die Einstellungsdialoge werden im Arbeitsbereich
mit Hilfe der Menlleiste/Navigierleiste eingeblendet. In den folgenden Kapiteln werden die Einstellungen
vorgestellt und deren Funktionen erlutert.

4.2.1 Sensorverbindung

Diese Software unterstltzt ausschlieBlich tecsis Gerate des Typs EZE21, EZE22.

Ist ein tecsis USB Gerat mit dem PC verbunden, wird dieser von der VASUSB automatisch aktiviert. Die
VASUSB kann Zeitgleich immer nur einen Sensor aktivieren. Mit einem einfachen Doppelklick in eine der
angezeigten Zeilen, in der der ,Status’ auf ,verfugbar steht, wird der gewiinschte Sensor aktiviert.
Sensoren, die in der Spalte ,Status’ mit ,nicht verfligbar gekennzeichnet sind, kénnen nicht aktiviert
werden. ,nicht verfliigbar’ bedeutet, dass die VASUSB die Schnittstelle nicht &ffnen oder nicht aktivieren
konnte, oder dass der Sensor nicht geantwortet hat. Wenn ein anderer Prozess oder eine andere
Anwendung auf die gewiinschte Schnittstelle zugreift, muss dieser Zugriff beendet werden und mit der
JAktualisieren’ Taste erneut nach freien Schnittstellen gesucht werden. Der Status ,nicht unterstitzt’
kennzeichnet nicht von dieser Software unterstitzte tecsis Sensoren.

Die Liste gibt weitere Informationen zum Sensor wie Baudrate (115,2 oder 230,4 kBaud), Adresse,
Seriennummer, Messbereichsendwert und Sensortyp an. Der Messbereichsendwert gibt entweder den
tatséchlichen Nennwert der Kandle an oder den Interfacetyp DMS, Strom oder Spannung. Beim
zweikanaligen EZE22 werden die Messbereiche mit einem Schragstrich getrennt dargestellt (Kanal A /
Kanal B).

Das Deaktivieren eines Sensors geschieht entweder durch die Aktivierung eines anderen Sensors oder
durch einen Doppelklick auf den aktiven Sensor. Beim Deaktivieren wird die COM Schnittstelle
freigegeben und kann von anderen Anwendungen verwendet werden.

4.2.1.1 Sensorverbindung > Baudrate

Die Baudrate kann hier mit Hilfe eines Klicks in der Spalte Baudrate auf die entsprechende Schnittstelle
(siehe Beispiel links ,Schnittstelle* ,tecsis USB [COM 13]“) zwischen 115,2 kBaud und 230,4 kBaud
umgeschaltet werden.

Baudrate = maximal einstellbare Messrate

:EDL Einkanal Zweikanal
115200 2500/s 1250/s
230400 5000/s 2500/s

@3 Die geanderte Baudrate wird im Sensor dauerhaft hinterlegt. Einstellung gilt auch im

Zusammenspiel mit anderen Anwendungen.

@ Die einstellbare maximale Messrate ist abh&ngig von der eingestellten Baudrate und dem
verwendeten Prozessor vom PC.

4.2.1.2 Sensorverbindung > Aktualisieren

Wahrend der Aktualisierung werden alle im PC eingebundenen ,tecsis USB* Schnittstellen Gberprift und
ausgelesen. Hierbei wird die Baudrate sowie die Geréteadresse ermittelt und automatisch eingestellt.
Des Weiteren werden samtliche Sensordaten und Sensorinformationen ausgelesen. Der Verlauf der
Aktualisierung wird visuell dargestellt (siehe folgende Abbildung).
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4.2.2 Sensorinformation

Datei Betriebsart Ansicht Sprache Hilfe

Navigierleiste i Sensorinformation

_+ Datei Allgemein

E Sp erte Sensor (SI-USB: Kraft / Spannung)
. Drucken
..[Z] Beenden

. Betriebsart

o Kenfigurationsmodus
% Sensorverbindung

Sensortyp: O 10 5
Seriennummer: 123456 Revision: 7

Werksjustierung

o AT Justierung erstelltam:  16.10.2013 aktiv

M instell
EESEInStE L-mgen Benutzerjustierung
Dokumentation

% Sensorjustierung Justierung erstelltam:  n.a, inaktiv

.. Mess- und Diagrammmodus
__ Ansicht
. _ Digitale Anzeigen

{:; Kznal A
{7 Kanal B A12345 120,0M 0,1% n.a,

Kanal &
Seriennummer Messbereichsendwert  Genauigkeitsklasse Messunsicherheit

T rALTVET} Kanal B

.-[7] MNavigierleiste Seriennummer Messbereichsendwert . Genauigkeitsklasse Messunsicherheit
Stat!.JsIerste_ B12345 Spannung 0,1% rn.a.
—jcte| Ansicht zurdcksetzen

_/ Sprache

-8 Deutsch

= English

-l Il Francais

. Hilfe

@ Info

@ Hinweis

Betriebsbereit. Sensor aktiviert Mi 181020013 1211 Uhr

A 4

Dieser Dialog zeigt Informationen und Eigenschaften zum aktivierten Sensor an. Die Daten liest die
VASUSB beim Aktivieren des Sensors aus. Ist kein Sensor aktiviert, so stehen alle Angaben auf ,n.a.”. Ist
die Messunsicherheit gleich ,n.a.’” bedeutet dies, dass beim aktivierten Sensor keine Messunsicherheit
hinterlegt ist. Dieser Wert in % kann bei einer tecsis-Werkskalibrierung oder bei einer DKD-Kalibrierung
ermittelt werden. Der ermittelte Wert kann im Meni ,Sensorjustierung’ unter ,Messunsicherheit im
Sensor hinterlegen’ im aktivierten Sensor abgespeichert werden.

EZE21, EZE22 verflgen jeweils Uber zwei Speicherplatze fur Justierwerte, einen unveranderlichen
Werksjustierblock und einen veranderlichen Benutzerjustierblock. Der Zustand ,aktiv' bei der
Benutzerjustierung ist zusatzlich mit einem ,* gekennzeichnet, falls diese Justierung die gleichen
Faktoren wie die Werksjustierung verwendet. Dies ist nach dem nachtraglichen Hinterlegen einer
Messunsicherheit bei aktiver Werksjustierung der Fall.

4.2.2.1 Sensorinformation - Allgemein

Hier finden Sie allgemeine Informationen zum angeschlossenen Sensor. Unter der Uberschrift ,Sensor*
finden Sie im Anschluss in Klammern die Sensorbezeichnung EZE21, EZE22 mit der Angabe des
Sensortyps (DM, Kraft ), wobei Kanal A und Kanal B mit einem Schréagstrich getrennt sind. Die Angaben
Sensortyp, Seriennummer, 1D, Revision und Werkskalibrierung sind unveranderliche Werksparameter.

4.2.2.2 Sensorinformation > Kanal A/B

Diese Felder beinhalten Informationen Uber den jeweiligen Messkanal. Im Fall eines EZE21 ist hier
ausschlieBlich der Kanal A sichtbar und bei einem EZE22 Kanal A und Kanal B. Die Seriennummer kann
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im Dialog Messeinstellungen unter ,MessgroBe - Darstellung - Seriennummer‘ vom Anwender
verandert werden (siehe folgendes Kapitel 4.2.3 Messeinstellungen). Tecsis GmbH empfiehlt hier die
Seriennummer des angeschlossenen Sensors einzutragen.

4.2.3 Messeinstellungen
Datei Betriechsart Ansicht Sprache Hilfe
Navigierleiste . Messeinstellungen
_: Datei Messgrafie
""" @ peichermn M Erie Art Tiefpassfiltter & Tiefpassfiter B Messrate
----- ﬁ Speichern Diagamm & 77
..... & Drucken [¥|Kanal & [J]KanalB |3000Hz  ~| [3000Hz  ~-| |00k ~|
----- Beenden Darstellung
 Betricbsart Machkommasztelle Einheit Mittelwert  VZ Skalierung  Seriennummer
=~ _+ Konfigurationsmodus Kanal A: |1 v‘ l[kNl v] ls]_z v| |+ vl Andern A12345
i :
m_ Sensorverbindung Kanal B: |2 v| |'u’ v‘ 1256 v| |+ v| | Andern l B12345
¢ Sensonnformation —
il :
1| Dokumentation
L. %f Sensorjustierung Dhagrami
..... @ Mess- und Diagrammmodus ¥-Achse: | Zeit vl Reduzierung der Messrate mit Mittelung tber 125 Werte.
-~ e YI—Arhse:ll(anaIA 'l YZ—Aﬁse:|KanaI B vJ
=~ Digitale Anzeigen
Trigger
Start
it QUE"E1|Syshemzeit v| 15102013 10:10:02 (TT.MM.3331  HH:mm:ss)
T nach Starten ausfihren: 3
----- Mavigierleiste =
----- Statusleiste Stopp —
..Jo Ansicht zuriicksetzen Quelle:|KanaIE v|F‘.i|:'-'|1:|_|ng:|unte:rst:hreiter'l v|Wert: 05 v
_/ Sprache L
B Deutsch nach Stoppen ausfithren: 1)
--ifm English
. I0/MNIC-E il
----- 1§ Francais L B s
erste Bedingung zweite Bedingung
7
| kanal & ~| =
Unterer Grenzwert Oberer Grenzwert Unterer Grenzwert Oberer Grenzwert
0,5 k] 0,6 [kN]
Betriebsbereit. Sensor aktiviert Mi 16102013  10:11 Uhr
L

In diesem Dialog kénnen die Messeinstellungen eingesehen und verandert werden. Die
Messeinstellungen sind aufgeteilt in MessgréBe, Diagramm, Trigger und IO/NIO-Bewertung. Die
vorgenommenen Einstellungen werden bis auf die Seriennummer ohne eine Bestatigung tbernommen.
Das Feld Seriennummer ist mit einer Sicherheitsabfrage gesichert. Die Sicherheitsabfrage erscheint nach
der ersten Verdnderung im Eingabefeld. Die Seriennummer ist begrenzt auf maximal 6 Zeichen. Mégliche
Zeichen sind GroB3- und Kleinbuchstaben von A bis Z sowie Zahlen von 0 bis 9.

Die Einstellungen in ,MessgroBe > Art‘, ,MessgroBe >Messrate‘, ,MessgroBe - Darstellung‘ und
,MessgroBe -> Diagramm -> Reduzierung der Messrate mit Mittelung tber X Werte‘ sind
Sensorbezogen und werden im Sensor abgespeichert. Somit ist eine automatische Konfiguration der
Software auf den angeschlossenen Sensor gewéahrleistet.

Beim Beenden der Anwendung werden die zuvor nicht erwéhnten Werte in der Windows Registrierung
unter dem angemeldeten Benutzer hinterlegt und nach einem Neustart der Software wiederhergestellt.

4.2.3.1 Messeinstellungen > MessgroBe > Art

Dieser Bereich dient zur Konfiguration der von der VASUSB erfassten MessgréBen. Beim Einstellen ist
darauf zu achten, dass zun&chst entschieden wird, welche Kanéle erfasst werden. Diese Einstellung ist
unter ,Messgrofte = Art’ entsprechend auszuwahlen. Nach der Umschaltung werden die Steuerelemente
und deren Inhalt in ,Messgrélie - Darstellung’, ,Messgrofle - Diagramm’ und in ,MessgréRe > Trigger’
entsprechend angepasst.
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@ Achtung: Die Auswahl von zwei Kanalen ist nur dann méglich, wenn ein tecsis Geréat des
Typs ,EZE22 ‘,oder des Typs ,EZE21 mit Digitaleingang‘ verbunden ist. Beim Typ ,EZE21°
ist die Einstellung fest auf Kanal A eingestellt und nicht veranderbar.

4.2.3.2 Messeinstellungen > MessgroBe > Tiefpassfilter
@D Achtung: Diese Auswahlmoglichkeit steht nur fiir das ,SI-USB‘ zur Verfiigung.

Mit dieser Einstellung wird der integrierte analoge Eingangsfilter konfiguriert. Die Einstellung erfolgt fur
jeden Messkanal separat.
Die folgenden 3dB-Frequenzen sind wéahlbar: 30 Hz, 300 Hz, 1000 Hz, 3000 Hz.

4.2.3.3 Messeinstellungen > MessgroBe = Messrate

Folgende Messraten sind wahlbar: 5000/sek, 2500/sek, 1250/sek, 1000/sek, 500/sek, 250/sek, 200/sek,
185/sek, 100/sek, 50/sek, 33/sek, 25/sek, 20/sek, 10/sek, 1/sek, 50/min, 20/min, 10/min, 1/min.
Die maximal einstellbare Messrate ist abhangig von der eingestellten Baudrate und dem verwendeten PC
System (siehe Kapitel 4.2.1.1 Sensor Connection - Baud Rate).

4.2.3.4 Messeinstellungen > MessgréBe > Darstellung

Die Konfigurationsansicht unterscheidet sich in Abhangigkeit vom angeschlossenen Gerat. Beim EZE21
wird nur ein Kanal dargestellt und beim EZE22 sind es zwei.

Darstefung
MNachkommastelle Einheit Mittelwert VZ Skalierung  Seriennummer
Kanal A: (3 v| M v (512 w| |+ v|[ Andem | A1234
Kanal B: f4 v | [vem v i-128 v‘ 5+ vl Andern | 812345

Die Einstellungen unter ,MessgréRe - Darstellung’ entscheiden Uber die Ausgabe und Anzeige des
jeweiligen Kanals. Hierbei kann fir jeden Kanal die Anzahl der Nachkommastellen, die Einheit, eine
gleitende Mittelwertbildung und das Vorzeichen aus einer Auswahl konfiguriert werden. Des Weiteren
kann jedem Kanal eine eigene Seriennummer zugewiesen werden.

Es kénnen bis zu vier Nachkommastellen flr jede physikalische GréBe angezeigt werden. Diese
Einstellung wird in den digitalen Anzeigen, im Diagramm und in der Ausgabe der CSV-Datei
berlcksichtigt. Bei der Einstellung der Einheit einer physikalischen GréBe stehen deutsche, englische
und amerikanische Einheiten zur Auswahl. Die Auswahl ist von der Typenklasse des angeschlossenen
Geréats abhangig. Die Umrechnung auf die eingestellte Einheit wird von der Software automatisch
ausgefuhrt. Die zusatzlich definierte Einheit unter ,Skalierung‘ wird in eckigen Klammern dargestellt. Eine
gleitende Mittelwertbildung kann firr jede physikalische GréBe lber 1 bis 512 Werte, mit einer Abstufung
im Raster 2", der eingestellten Messrate gebildet werden. Das Vorzeichen des Kanals ist im Sensor
vordefiniert, mittels der Einstellung unter ,Messgrole - Darstellung > VZ' kann dieses verandert
werden.
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Die Taste ,Andern® unter Skalierung dffnet einen Dialog in dem eine Skalierung sowie eine Definition
einer zuséatzlichen Einheit ausgefihrt werden kann. Die zusétzliche Einheit ist im Auswahifeld, Messgrdfi3e
- Darstellung - Einheit mit eckigen Klammern gekennzeichnet.

Skalierung Andern gy
Kanal A
Sensarjustierung
Kraft: 10,0 kM entspricht 25000 ADU
Skalierung
aktuellen
Messwert 10,0 kM entspricht 12500 M
einlesen
| Andern | | Abbrechen ]

Im Dialog ,Skalierung Andern‘ kann die EingangsgroRe (siehe vorherige Abbildung ,Skalierung Andern’
unter der Uberschrift ,Sensorjustierung’) mit einer beliebigen Einheit umskaliert werden. Die
Sensorjustierung gibt die definierte Werks- bzw. Benutzerjustierung des Kanals wieder. In der Abbildung
ist Kanal A ausgewahlt mit der Eingangsgré3e Kraft die bei 10,0 KN Nennwert 25000 ADU ausgibt. Mit
Hilfe der Eingabefelder in der Box Skalierung kann nun eine Umskalierung dieser Werte ausgefuhrt
werden. Im linken Eingabefeld kann entweder ein bestimmter Kraftwert eingetragen, oder der aktuelle
Messwert vom Sensor eingelesen werden. Im mittleren Eingabefeld ist der neue Ausgabewert
einzutragen der dem Eingangswert aus dem linken Feld entspricht. Im rechten Feld kann noch eine
Einheit mit maximaler Lange von 5 Zeichen eingetragen werden. Diese Eingaben werden beim Betéatigen
der Taste Andern® im Sensor abgespeichert und die Anwendung stellt unter ,MessgroRe > Darstellung
- Einheit’ die neu Definierte ein.

@ Achtung: Je naher der Skalierwert am Endwert des Sensors liegt, desto genauer ist die
Anzeige vom Messwert bei einer Messung.

4.2.3.5 Messeinstellungen - Diagramm

Diagramm
¥-Achse: | Zeit - | Reduzierung der Messrate mit Mittelung Ober 125 Werte,
Y 1-Achse: | Kanal A - | ¥ 2-Achse: | Kanal B -

Im Eingabefeld ,Reduzierung der Messrate mit Mittelung Gber X Werten.’ ist es moglich, die Anzahl der zu
speichernden Messpunkte zu verringern, indem Sie einen Wert fir X eintragen. Die eingestellte Messrate
z. B. 200/sek, wird folglich bei X=10 auf 20 Messwerte pro Sekunde reduziert und im Diagramm
dargestellt. Beim Speichern der Messwerte in eine Datei ist es ebenso. Bei der Reduzierung der
Messrate findet eine Mittelung Uber jeweils X Werte statt.

@D Die Einstellung ,Reduzierung der Messrate mit Mittelung Gber X Werten.” hat keine
Auswirkung auf die Anzeigewerte in den digitalen Anzeigen.

@: Die Einstellungen unter 4.2.3.4 Messeinstellungen > MessgréBe -> Darstellung >
Mittelwert des einzelnen Kanals und die Einstellung ,Reduzierung der Messrate mit
Mittelung Gber X Werten.” wirken kumulativ.

@3 Bei der Aktualisierung des Diagramms wéahrend einer laufenden Messung wird bei einer
resultierenden Messrate kleiner gleich 20 Messungen pro Sekunde die vollstandige
Messung dargestellt. Bei Messraten Uber 20 Messungen pro Sekunde werden nur die
letzten 5 Sekunden der Messung dargestellt. Nach dem Beenden einer Messung wird

dann immer die vollstandige Messung im Diagramm angezeigt.

® Ist noch keine Skalierung hinterlegt so erscheint hier statt ,Andern‘ der Begriff ,Erstellen‘ und die
Auswahl im Feld Einheit beschrénkt sich auf den Geréatetyp ohne eine zusétzliche Einheit.
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Beim Einstellen dieser Konfiguration sollte mit der X-Achse begonnen werden. Resultierend aus der
Einstellung der X-Achse aktualisiert die Anwendung die Anzahl der Y-Achsen sowie deren auswahlbaren
Inhalt. Sdmtliche Kombinationen der MessgréBen kénnen im Diagramm dargestellt werden.

@ Achtung: Die Messwerte werden genau mit diesen hier eingestellten Kanélen in die CSV -

Datei geschrieben. Die Reihenfolge beim Schreiben ist: [X-Achse], [Y1-Achse], [Y2-Achse]. Es
ist auch mdoglich Y-Achsen auf ,Aus’ einzustellen falls diese nicht bendétigt werden. Die
Anwendung achtet jedoch darauf, dass mindestens eine GréBe auf der Y-Achse nicht auf
JAus’ steht.
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VASUSB
4.2.3.6 Messeinstellungen > Trigger
Ablauf:
1. Startereignis auswahlen. Ausgangszustand
2. Stoppereignis auswahlen.
3. Trigger Taste betatigen. Messung AUS
4. Triggerstart Ereignis auslosen. > Trigger ~ AUS <
5. Triggerstopp Ereignis ausldsen. | S
6. Messung aufgezeichnet. _ e | O grau )
Y
Trigger betatigt?
Nein
Ja
\ 4
| Messung AUS
| Trigger EIN
Tser | 34 gelb blinken
Y
Triggerstart Ereignis erfllt?
. ODER
Nein Messen Start betatigt?
Ja
\4
| Messung  EIN
~| Trigger EIN
Trigger o gr[]n
Y
Triggerstopp Ereignis erflllt?
Nein ODER g
e Messen Stopp betéatigt? a
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Im vorherigen Signalflussdiagramm ist der allgemeine Ablauf einer Messung mit Hilfe einer Triggerung
beschrieben. Die Aktivierungstaste ,Trigger’ der Triggerfunktion ist im ,Mess- und Diagrammmodus’
unterhalb von ,Messen Stopp’ zu finden. Die Softwaretriggerung besteht aus zwei Ereignissen, die nach
der folgenden Beschreibung den Anforderungen entsprechend einstellbar sind:
o Triggerstart 2 Quelle:
o Aus/Messen Start:
Betétigen von ,Messen Start’ 16st das Triggerstart-Ereignis aus. (Diese Funktion steht
auch in den folgenden Quellen zur Verfligung um das Startereignis zu setzen).
o Kanal A/ Kanal B:
Siehe Kapitel 4.2.3.6.1 Trigger.
o Systemzeit:

Anwendung zeigt ein Eingabe- =

feld ar_]! n dem das Datum Quelle: | Systemzeit | 16.10.2013  10:20:27 144 (TT.MM.111] HH:mm:ss)
und die Uhrzeit des Starts

einer Messung eingestellt wer- ~
den kann. Die Einstellung ist einseitig begrenzt auf die aktuelle Uhrzeit plus 15
Sekunden. Selbstverstandlich ist dieser Wert nach jeder Messung neu anzupassen.
Anderenfalls startet die Folgemessung mit dem Betatigen vom Trigger sofort, da der
immer noch eingestellte Zeitpunkt in der Vergangenheit liegt.
o Triggerstopp 2 Quelle:
o Aus/Messen Stopp:

Das betatigen von ,Messen Stopp’ I6st das Triggerstopp Ereignis aus. (Diese Funktion
steht auch in den folgenden Quellen zur Verfligung um das Stoppereignis zu setzen).

nach Starten ausfiihren: @

o Kanal A/ Kanal B: Stopp
Siehe Kapltel 423.6.1 Trigger_ QUE"E:|K‘3”5|E v|Rit:hb.|ng:|unhtars:t:hreihtan v|Wert: 0,5 v
o MeSSdauel‘: nach Stoppen ausfilhren: @

Bei dieser Auswahl steht ein
Eingabefeld zur Verfligung. Die Zeiteinheit (Sekunden, Minuten) leitet die Anwendung
von der Messrate ab. Die Anzahl an Messungen wird von der Anwendung neben dem
Eingabefeld bei einer Eingabe berechnet und angezeigt.

o Anzahl Messungen:
Bei dieser Auswabhl steht ein Eingabefeld zur Verfliigung um die Anzahl an Messpunkten
vorzugeben. Die Messdauer wird von der Anwendung neben dem Eingabefeld bei einer
Eingabe berechnet und angezeigt. Die Zeiteinheit (Sekunden, Minuten) leitet die
Anwendung von der Messrate ab.

@ Hinweis: Die Quelleneinstellungen von Triggerstart und Triggerstopp kdnnen beliebig

miteinander kombiniert werden.

@ Hinweis: Die Einstellungen ,Messdauer® und ,Anzahl Messungen® beziehen sich auf die
eingestellte Messrate und nicht auf die Reduzierung der Messrate.

Nach Starten / Stoppen ausfiihren: beiden Triggerereignissen kénnen Uber diese Felder Aktionen zu-
geordnet werden. Nach dem Auftreten des Ereignisses und eventuellen Auswerte- und Speicheraktionen
wird das in diesem Feld angegebene Programm ausgefihrt.

Zulassig sind beliebige ausfihrbare Dateien sowie Stapelverarbeitungsdateien (.bat). Sie kbnnen manuell
mit vollstdndigem Pfad angegeben oder Uber einen Requester Uber das Ordner-Symbol ausgewahlt
werden.
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4.2.3.6.1  Trigger

Die Abbildung auf der folgenden Seite  rrigger
zeigt ein Beispiel, wie eine Messung Start
mit Hilfe der Triggerung auf eine Quele: Kanal A - |Richtung: berschreiten | Wert: 2,5 mypN
physikalische GréBe aufgezeichnet

nach Starten ausfiihren: @
werden kann. Der Wert der Hysterese
ird  beim  Uberschreiten vom > ———
wir . QLIE||E:|KanaIB 'lRichtung: unterschreiten - | Wert: 0,56  kN*m
Schwellwert abgezogen und beim
Unterschreiten dazu addiert. Die nach Stoppen ausfiihren; @

Berechnung der Hysterese fir jede
mogliche physikalische GrdBe ist unterhalb des Beispieldiagramms auf der folgenden Seite aufgefihrt.
Bei dieser Triggerung ist nicht nur der Schwellwert (Yiper; Zuver) €iner physikalischen GréfBBe vorzugeben,
sondern auch eine Richtung. Im Beispieldiagramm wird jeweils auf die Richtung ,lberschreiten’
getriggert. Dies bedeutet, dass der gemessene Wert zundchst unter den Hysteresewert abfallen muss
bevor der Trigger auf das Uberschreiten des Schwellwerts reagiert. Im Gegensatz dazu bedeutet die
Einstellung auf ,unterschreiten’, dass der gemessene Wert zunachst tber den Hysteresewert ansteigen
muss bevor der Trigger auf das Unterschreiten des Schwellwerts reagiert.
Der grau eingerahmte Bereich des Beispieldiagramms entspricht, nach Ablauf der Messung, der Anzeige
im Diagramm der VASUSB. Dieser Bereich kann in die CSV Datei abgespeichert werden.

e Yiver = Triggerstartwert einer physikalischen Grofte mit Richtungseinstellung ,iberschreiten’

e Zner = Triggerstoppwert einer physikalischen Gréf3e mit Richtungseinstellung ,uberschreiten’

4.2.3.6.2 Beispieldiagramm

Kanal A/ Kanal
R A s e
Yiber : - Hysteres
: Triggerstart - :
. Ereignis .
: : >t
. ) . —
1 riggerstopp =
Ereignis :  /
Ziber \)/ Hysteres

4.2.3.6.3 Hysterese

Die GroBe der Hysterese liegt bei 1% des angegebenen Nennwerts des angeschlossenen Sensors.
AuBer bei den Typklassen DMS, Strom und Spannung wird die Hysterese auf ca. 1% des maximalen
Eingangswertes skaliert da der Nennwert in der Regel nicht bekannt ist.

4.2.3.7 Messeinstellungen = 10/NIO-Bewertung

Diese Einstellungen beeinflussen die Bewertung einer Messreihe, ~ 10/MNIO-8ewertung
Nach Auftreten eines Trigger-Stopp-Ereignisses werden die sesiiioy

. . . . . . '
Maximalwerte dieser Messreihe ermittelt und mit den hier
hinterlegten Grenzen verglichen. Um eine 10-Anzeige zu erhalten |kanal & 7
muss der Maximalwert einer Messreihe Uber dem unteren Grenz- T e I T
wert und unter dem oberen Grenzwert liegen. 0,5 my v 0,6 my v

Werden zwei Bedingungen definiert, missen beide Bedingungen
fir sich den IO-Kriterien entsprechen, um insgesamt 10 anzuzei-
gen.
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4.2.4 Dokumentation

Datei Betriebsart Ansicht Sprache Hilfe
Mavigierleiste x

Dokumentation
T Ausgabe Messwerte Zeilenendezeichen:
..... & Speichern Diagramm automatische Speicherung: [Alle Messungen in eine Datei schreiben vJ | [CRLF] vJ
""" @ Drucken Zielverzeichnis: ald\Documents\Vs2 Eﬂ Prafic: TAE Spaltentrennzeichen:
----- Beenden —
.+ Betriebsart Ausgabe IO/NIC-Bewertung H '|
= = Konfigurationsmedus automatische Speicherung: |Alle Messungen in eine Datei schreiben vJ B e e Lt

4% Sensorverbindung

i Ziehverzeichnis: A E ] 2
%! Sensorinformation aid\DocumentsiVs2 Q Prafic: ERG |[’]7|
[M] Messeinstellungen zusatzliche Informationen ein-fausblenden

&) Dokumentation [”] Oberschrift Messunsicherheit [¥] Datum  Uhrzeit

L 0F Sensorjustierung

[Tl adresse [ Bemerkung

i |¥|phys, Einheit
----- [®] Mess- und Diagrammmodus

.+ Ansicht

= _+ Digitale Anzeigen Ausgabe Diagramm

automatische Speicherung: |Jedes Diagramm mit eigenem Index anlegen -

Ziehverzeichnis: old\Documents\Ws2 IFQ! Prafix: DGM

Speichergrife: | normal  w

--[7] Statusleiste o .
_____ i@ Ansicht zuriicksetzen zusatzliche Informationen

Siiriche Uberschrift
=

. Deutsch Measure - Measure K25
..ofe English

----- B 0 Francais
. Hilfe

@ Hinweis

Adresse Bemerkung

Dipl. Ing. K. Mustermann

_Br:triebsbereit. Sensor aktiviert Mi 1610.2013  10:50 Uhr

Hier kann der Anwender Konfigurationen zur eigenen Dokumentation vornehmen. Die Einstellungen be-
treffen die Speicherung von Messungen als BMP- und CSV-Datei.

4.2.4.1 Dokumentation - Ausgabe Messwerte

o automatische Speicherung:
Das Speichern der Messwerte in eine Ausgabedatei kann von der Software automatisch erfolgen.
Dafur stehen drei Einstellungsmdéglichkeiten zur Auswahl.

o keine: Die automatische Speicherung ist ausgeschaltet.

o Alle Messungen in eine Datei schreiben: Diese Option hangt jede weitere Messung an
die gleiche CSV-Datei am Ende an. Der Name aus dem Feld Préfix wird als Dateiname
verwendet. Die Datei wird im eingetragenen Zielverzeichnis abgespeichert.

o Jede Messung mit eigenem Index anlegen: Diese Option erstellt am Ende jeder
Messung eine separate CSV-Datei. Der Dateiname setzt sich aus dem Préfix und dem
Index JJJUIMMTTHHmMmss#HH# (##H#H# Zahl mit Vornullen beginnend 0000; 0001; ...)
zusammen.

@ Die Pfadlange ist durch das Betriebssystem begrenzt.

@ Hinweis: Definition ,Messung” siehe Kapitel 4.1.1 Datei > Speichern Messwerte
(Tastenkombination ,Strg+M’)
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Zielverzeichnis: D ==
Unter Zielverzeichnis’ wird der  Zielpfad eingetragen it wabien S e Ordrer in der s s
(Standardeinstellung...\<xBenutzername>\Eigene Dateien\VASUSB).

Offentlich

Sie kénnen stattdessen mit einem Klick auf den Ordner in einem N Compuer
f f . : = & tentrager (C:
Auswahldialog ein Verzeichnis auswahlen. it ol
Prafix: = 05.TOOLS (E)
—_— . i i . &3 DVD-RW-Laufwerk (F;)
In dieses Eingabefeld tragen Sie bitte den Dateinamen, der zur B Vot e ) )|

automatischen Speicherung verwendet werden soll, ein (weitere || @ @ e
Details zum Dateinamen/Préfix finden Sie unter der Uberschrift lf:;di‘;l e
,automatische Speicherung’). _— -

4.2.4.2 Dokumentation - Ausgabe Diagramm

Automatische Speicherung:
Das Speichern der Messwerte in eine Ausgabedatei kann von der Software automatisch erfolgen.

Dafur stehen drei Einstellungsmdéglichkeiten zur Auswahl.

o keine: Die automatische Speicherung ist ausgeschaltet.

o Alle Messungen in eine Datei schreiben: Diese Option hangt jede weitere Messung an
die gleiche CSV-Datei am Ende an. Der Name aus dem Feld Préfix wird als Dateiname
verwendet. Die Datei wird im eingetragenen Zielverzeichnis abgespeichert.

o Jede Messung mit eigenem Index anlegen: Diese Option erstellt am Ende jeder
Messung eine separate CSV-Datei. Der Dateiname setzt sich aus dem Préfix und dem
Index JJJUIMMTTHHmmss###H# (###H# Zahl mit Vornullen beginnend 0000; 0001; ...)
zusammen.

@D Die Pfadlange ist durch das Betriebssystem begrenzt.

Zielverzeichnis: D =
Unter Zielverzeichnis’ wird der  Zielpfad eingetragen Bt wible S e Ordet i e e s
(Standardeinstellung...\<Benutzername>\Eigene Dateien\VASUSB).

Sie kdénnen stattdessen mit einem Klick auf den Ordner in einem e
Auswahldialog ein Verzeichnis auswahlen. e meee
Préfix . w 05_TOOLS (E:)
— . . . . oL DVD-RW-Laufwerk (F:)
In dieses Eingabefeld tragen Sie bitte den Dateinamen, der zur 2 Vet e )

automatischen Speicherung verwendet werden soll, ein (weitere
Details zum Dateinamen/Préfix finden Sie unter der Uberschrift
,automatische Speicherung’).

Kicken Sie auf das Symbol neben einem Ordner, um
Unterordner anzuzeigen.

[ even Ordner erstelen 0 Abbrechen

4.2.4.3 Gemeinsame Einstellungen Ausgabe Messwerte und Ausgabe 10/NIO-Bewertung

Zeilenendzeichen:

In dieser Auswahlbox ist das Zeilenendzeichen der Ausgabe in eine Datei einzustellen. Folgende
Méglichkeiten stehen zur Auswahl:

CRLF : Carriage Return / Line Feed Wagenricklauf Zeilenvorschub (MS-DOS, Windows)

LFCR : Line Feed / Carriage Return Zeilenvorschub Wagenriicklauf (Linux Konsole)
CR : Carriage Return Wagenriicklauf (Apple II, Apple Mac OS bis Version 9)
LF : Line Feed Zeilenvorschub (Unix-Derivate, Mac OS X)

Spaltentrennzeichen:

Das Spaltentrennzeichen, auch Listentrennzeichen genannt, wird beim ersten Ausfiihren der An-
wendung aus der Windows Systemsteuerung (L&ndereinstellungen) ausgelesen und ent-
sprechend gesetzt. Bei jedem weiteren Starten der Anwendung wird das zuletzt Eingestellte wie-
der verwendet. Folgende Auswahl kann in dieser Box vorgenommen werden.

TAB : Tabulator

; : Semikolon

, : Komma

. : Punkt

Leer : Leerzeichen

Dezimaltrennzeichen:

Beim Dezimaltrennzeichen wird wie beim Spaltentrennzeichen erlutert vorgegangen. Folgende
Auswahl kann in dieser Box vorgenommen werden.
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, : Komma
. Punkt

@3 Hinweis: Die nachtrigliche Anderung der Landereinstellungen im Betriebssystem
haben keine Auswirkungen auf die einmal eingestellten Werte dieser Software.

zusatzliche Informationen ein-/ausblenden:

In dieser Gruppe kénnen Haken gesetzt werden, um die Ausgabe der Messwerte um weitere
Informationen zu ergénzen. Die Eintrage in den drei Eingabefeldern ,Uberschrift’, ,Adresse’ und
,Bemerkung’ kénnen beliebig vorgegeben werden. Diese Eintrdge werden dann bei gesetztem
Haken in der Ausgabedatei im Kopf eingetragen. Die ,Messunsicherheit’, falls der verbundene
Sensor mit einer solchen versehen ist, kann auch in der Ausgabedatei erscheinen. Der Zeitraum
einer Messung kann mit Hilfe eines Hakens bei ,Datum / Uhrzeit’ in die Ausgabedatei geschrie-

ben werden. Mdglich ist es auch, die Einheiten der physikalischen GréBen in der Ausgabedatei
gezielt ein- bzw. auszublenden mit einem Haken bei ,phys. Einheit’.

4.2.4.4 Dokumentation = zuséitzliche Informationen

Hier stehen die Freitexte, die unter ,Dokumentation > Ausgabe Messwerte - zusatzliche Informationen
ein-/ausblenden’ aktiviert werden kénnen.

4.2.5 Sensorjustierung
Datei Betriebsart Ansicht Sprache Hilfe
Navigierleiste = Sensorjustierung

o Datei

Messunsicherheit im
Sensor hinterlegen

@ Drucken
Beenden
.+ Betriebsart

Ei) Konfigurationsmodus
_ﬁ) Sensorverbindung
% Sensorinformation
[M1] Messeinstellungen
Dokurmentation

-.{®] Mess- und Diagrammmodus
.+ Ansicht
i}~/ Digitale Anzeigen

{:} Fanal A

fagrarmm
--[Z] Mavigierleiste
-[£] Statusleiste
_ Sprache

..M Deytsch
= English

.1 B Francais

.+ Hilfe

@ Info

..CT3 Hinweis

Betriebsbereit. Sensor aktiviert

A

Mi 16102013  11:06 Uhr

In diesem Dialog kann im verbundenen Sensor eine Messunsicherheit in % abgespeichert werden. Diese
GroBe, falls sie vorhanden ist, zeigt die Anwendung im Mess- und Diagrammmodus und in den
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Sensorinformationen an. Des Weiteren kann die Messunsicherheit in der CSV Ausgabedatei ausgegeben
werden (siehe Kapitel 4.2.4.1 Documentation - Output Measured Values).

Messunsicherheit im Sensor hinterlegen:

Diese Funktion ermdglicht es, im Sensor einen maximalen Wert fir die Messunsicherheit zu
hinterlegen. Dieser Wert wird in der Regel bei einer Werks- oder DKD-Kalibrierung bestimmt.
Wenn die Werksjustierung des angeschlossenen Sensors aktiv ist und ein Wert bei der Mess-
unsicherheit angegeben ist, so wurde der Sensor von der Firma tecsis GmbH einer Werks- oder
DKD-Kalibrierung unterzogen. Zulassige Werte fir die Messunsicherheit sind [5 % >
Messunsicherheit > 0 %]. Dieser Wert wird dann bei angeschlossenem Sensor im ,Mess- und
Diagrammmodus’, in den ,Sensorinformationen’ und, falls gewlinscht, in der CSV-
Ausgabedatei aufgefihrt. Dieser Wert dient nur zur Dokumentation. Auf die Messwerte hat dieser
Wert keinen Einfluss.
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4.3 Mess- und Diagrammmodus

@ Achtung: Wéahrend einer Messung darf die Datenverbindung zum PC nicht
unterbrochen werden!

Datei Betriebsart Ansicht Sprache Hilfe

Mavigierleiste % Mess- und Diagrammmeodus Kanal A %
. Datei
----- B Speichern Messwerte Messen Start = 1 ,5 N
----- & Speichem Diagramm : :
..... e e [T 5N 1384N
v - TARA M Resst MAK Resst
----- Beenden A & l
i Trigger Trigger automatisch
Betriebsart jel]
i einschalten O E|\c\'iech2rho|er1

.__; Konfigurationsmodus
----- % Sensorverbindung
----- % Sensorinformation

Messeinstellungen Kantrolle O Kanal B =

(5] Dokumentation

Einzelmessung |

..... % Sensorjustierung '0 24 cm
----- [®] Mess- und Diagrammimodus = e
.+ Anzicht 100em S4om 4d5em
i _s Digitale Anzeigen Messrate: 1250/sek T N e

-4 Kanal &

Kanal B

.[2 10/NIO-Bewertung
..... Diagramm

..... Mavigierleiste

..... Statusleiste

..... [ Ansicht zuriicksetzen
_+ Sprache

..M Deutsch

.atm English

..... B 0 Francais

_ Hilfe

(D Info

Seriennummer: n.a.
Messbereichsendwert (A /B ): 120,0 N f Spannung
Messunsicherheit: n.a.

10/NIO - Bewertungsanzeige x

| i

Kanal AT
]
1400
A200-| -
100.0-| -

200

0.0 | -

- - — — — ; : — — — ; b
2.000 1.200° 2.400 2.E00 2200 1,000 '1200 1.400 1,600 4.800 2000 2200 2400 Zeit [SBK]I

+ 4

Diagramm

Betrichsbereit. Sensor aktiviert Mi 16102013 1203 Uhr

Im ,Mess- und Diagrammodus’ sind die digitalen Anzeigen der physikalischen GréBen und das
Diagramm aktivierbar. Es sind nur die Anzeigen aktiviert, die unter ,Messeinstellungen>MessgréBe—>Art’
mit einem Haken versehenen sind.

Die digitalen Anzeigen befinden sich, ebenso wie das Diagramm, in je einem eigenstédndigen Fenster.
Diese Fenster kdnnen im Hauptfenster angedockt oder auch frei auf dem Monitor platziert werden. Zum
Verschieben der Fenster platziert man den Mauszeiger auf der Titelleiste des jeweiligen Fensters. Mit
gedrickter linker Maustaste kann das Fenster dann versetzt oder angedockt werden. Der Inhalt der
Fenster passt sich automatisch an der FenstergroRe an. Mit Dricken der Taste ,Strg’ kann das Andocken
an das Hauptfenster verhindert werden.
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Aufgrund systembedingter Einschrédnkungen ist es bei den Betriebssystemen Windows 2000 und
Windows XP nicht méglich, das Diagramm aus dem Hauptfenster der Anwendung zu ziehen. Zudem
kann die Anwendung bei diesen Betriebssystemen nicht auBBerhalb des Monitors platziert werden. Beim
Versuch springt diese immer wieder zurlick in den zul&ssigen Bereich.

Jede digitale Anzeige verfligt Gber vier Ausgabefelder, je eines flr den aktuellen Messwert, den tarierten
Wert, den minimal Wert und den maximal Wert. Der Minimalwert und der Maximalwert kann je mit den
Tasten ,MIN Reset’ und ,MAX Reset’ zuriickgesetzt werden. Wenn in der Taste Tarieren ,TARA’
angezeigt wird, und dieser dann gedruckt wird, setzt das den aktuell gemessen Messwert auf Null und die
tarierte Differenz wird im Ausgabefeld oberhalb angezeigt. Im Anschluss steht in dieser Taste ,TARA=0’
hiermit kann die Tarierung wieder aufgehoben werden.

Die I0/NIO-Anzeige zeigt immer das Gesamtergebnis aller definierten Kriterien an. Werden alle Kriterien
eingehalten, erscheint eine griine Anzeige. Ist mindestens ein Kriterium nicht erfillt, wird die Anzeige rot.
Eine graue Anzeige bedeutet, daB aktuell keine Bewertung vorliegt, z.B. nach dem Programmstart oder
nachdem eine neue Messreihe gestartet wurde.

Messen Start:
Mit dieser Taste wird eine Messung gestartet.
Die digitalen Anzeigen sowie das Diagramm werden nach dem Driicken dieser Taste mit Messwerten
geflllt. Nicht benétigte Tasten sind wahrend dem Messen deaktiviert. In der Statusleiste wird zudem der
Status der Anwendung ,Messen..." ausgegeben.

= Software Trigger-Start Ereignis

Messen Stopp:
Kann nur bei aktiver Messung betatigt werden. Sobald diese Taste betétigt wird stoppt die Messung und
leitet eine evtl. automatische Speicherung ein (siehe Kapitel 4.2.4 Documentation). In der Statusleiste
wird bei aktiver automatischer Speicherung in eine Datei der Fortschritt angezeigt und anschlieBend der
Ruhezustand ,Betriebsbereit. Sensor aktiviert'.

= Software Trigger-Stopp Ereignis

Trigger:

Mit dieser Taste wird eine unter Kapitel 4.2.3.6.1 Trigger erklarte Softwaretriggerung aktiviert. Die
Statusleuchte seitlich der Taste blinkt bei aktivierter Triggerung gelb. Durch ein erneutes Betatigen wird
die Triggerung wieder deaktiviert. Der Ablauf einer Softwaretriggerung ist in Kapitel 4.2.3.6
Messeinstellungen - Trigger beschrieben.

Trigger LED \ Zustand \
Grau Trigger AUS

Trigger wartet auf Triggerstart Ereignis.
gelb blinkend | Nur die digitalen Anzeigen werden
aktualisiert.

Trigger Messung EIN. Digitale Anzeigen
Grin und Diagramm werden mit Werten
aktualisiert.

Trigger automatisch wiederholen:

Ist ein Haken gesetzt, wird der Trigger, sobald alle Aktionen des Trigger-Stopp-Ereignisses abgearbeitet
sind (z. B. Datei schreiben. Siehe automatische Speicherung in Kapitel 4.2.4.1 Documentation > Output
Measured Values und Kapitel 4.2.4.2 Dokumentation - Ausgabe Diagramm) wieder aktiviert.

@Nur aktivierbar, wenn eine automatische Speicherung in 4.2.4.1 oder 4.2.4.2 akitiv ist.

Einzelmessung:
Mit Hilfe dieser Taste wird ein einzelner aktueller Messwert vom aktivierten Sensor angefordert und in der

digitalen Anzeige ausgegeben. Diese Funktion geht nur im Ruhezustand/Messen Stopp der Anwendung.

Kontrolle:
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Die Taste ,Kontrolle’ ist nur bei niedrigen Messraten wahrend der Messung aktiv (<20/sek) und im

Ruhezustand.

Mit Hilfe der Kontrolle wird die DMS Messbriicke im Sensor verstimmt und gibt ihren Nennbereich aus.
Eine rote Leuchte neben der Taste kennzeichnet eine aktive Kontrollaufschaltung. Mit einem erneuten
Klick auf ,Kontrolle’ kann diese wieder deaktiviert werden.

5 Fehlerbeseitigung

Diese Tabelle dient zur Suche der haufigsten Fehler und deren MaBnahmen zur Behebung.

Stérung

Mégliche Ursache

Beseitigung

Anwendung startet nicht

Als Betriebssystem wird WIN98 oder

alter verwendet.

Erforderliches Betriebssystem
WIN 2000; WIN XP; WIN VISTA;
WIN 7, WIN 8

Treiber fir USB Sensoren fehlen

Installieren Sie das Treiberpaket
von der Produkt CD. Treiber nur
unter Administratorrechten in-
stallieren.

Sensor ist noch nicht mit PC
verbunden

Verbinden Sie den Sensor mit
dem PC

Sensor ist mit dem PC
verbunden jedoch findet keine
Kommunikation statt oder die
Anwendung startet nicht.

Treiberprobleme oder das
Fehlverhalten der USB Verbindung

SchlieBen der Anwendung und
aus- und einstecken der USB-
Verbindung zwischen Sensor und
PC
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1 Remarks

This manual describes the installation under Windows Vista. The installation under Windows 2000, XP
and Windows 7 and Windows 8 occurs accordingly.

Please note that Windows imperatively requires administrator rights for the installation of drivers!
Please speak to your administrator if you do not have those rights!

1.1 License Terms for this Software

The copyrights for this software remain at:

tecsis GmbH
Carl-Legien-Str. 40-44
63073 Offenbach

Germany

During the software installation, the license conditions will be displayed and must be accepted, otherwise
the installation will be aborted. After the installation, the license conditions can be viewed in menu
‘Help > Advice’.

1.2 Intended Use

The VASUSB software was designed for the adjustment, control and read-out of the EZE21 or the SI-
USB. Further functions of the VASUSB are reception, display and storing of measured values. Any use
beyond this is considered as not intended.

1.3 Designation of the Remarks

If possible remaining dangers emerge during the operation with VASUSB; this will be indicated by the
following symbols in this operation manual:

@ Note:
Important points to consider

1.4 System Requirements

The operation of VASUSB requires a PC with following system conditions:
e Windows 2000, Windows XP, Windows Vista or Windows 7 / Windows 8
e For EZE220r EZE21: USB-Interface
e Maximal two monitors will be supported

Recommended Hardware Requirements:
e Application process without diagram: Single-Core from 2,0 GHz
e Application process with diagram:  Dual-Core from 1,8 GHz
e The higher the sampling rate and the longer a measurement lasts, the higher the required main
storage should be. The measurement ends as soon as the system does not provide anymore free
main storage space. The absolute size of the main storage is depending on the operation system
and the components installed in addition.
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2 Preamble

2.1 Product Description

This operation manual describes characteristics and operation
courses of the VASUSB.

2.2 Setup of the Software

The VASUSB consists of following components:
e Configuration possibilities for the VASUSB
e Storage of sensor-related scaling and adjustment data
o Display for the presentation of measured data (actual value, tare value, minimal value and
maximal value)
Display and storage of measured data evaluations
Presentation of the measured data in a diagram
Storage of measured data in CSV-format (output configurable)
Storage of the diagram in BMP-format (output size configurables )
Print-out of the diagram (output size defined)
Presentation of the sensor information

2.3 Safe and Correct Use

@ Observe the correct sensor adjustment.
@ Consider the correct VASUSB configuration.
@ Choose a significant file identification/prefix when storing measured data.

3 Starting the Software

The software starts only if it identifies a compatible sensor® at the USB connection. After starting the
executable file, the search for a compatible USB sensor' is displayed. If the search is unsuccessful,
check whether the USB circuit at the sensor is connected to the PC and whether the USB drivers have
been installed. Then click on ‘Search again’ to restart the search for a compatible sensor. If a compatible
sensor was found, the sensor-related data will be read-out automatically.

® Compatible sensors: EZE21, EZE22
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4 Description of the Operating Mode

The software consists of a menu bar, navigation bar, status bar and a workspace. The functions of the
menu bar comply with the navigation bar. The digital measured values of the physical values, the
valuation display and the diagram can be seen in ‘Operating Mode > Meas./Diagram Mode’. In the
workspace the consolidated dialogs are displayed in ‘Operating Mode’.

e Adjust. Mode (see chapter 4.2)

¢ Meas./Diagram Mode (see chapter 4.3)
Switching between the dialog boxes can be done through the navigation bar as well as through the
coequal menu bar. Adjustment changes in the dialog box will be accepted without confirmation.
All adjustments are stored when quitting the application and will be loaded when the application gets
restarted.
The status bar displays current status information of the application

e ‘Ready for use. Sensor connected’

e ‘Sensor disconnected’

e ‘Measure...

e ‘wait for trigger start event’

e ‘Measure! Wait for trigger stop event’
Furthermore, information from the menu bar and navigation bar through the control elements as well as
the storage progress in a CSV-file are indicated in the status bar.

4.1 The Menu Bar/Navigation Bar of the Program

4.1.1 File > Save Measvalue (Shortcut ‘Ctrl+M\’)

From here, the measured data of the last measurement’” are

stored in a CSV-file. The output format of the file is adjustable in  wmessung1.a

dialog box ‘Operating Mode -> Adjust. Mode -> ...
Documentation’ under the headline ‘Output measured values’  torenz Messtechnix GmbH
(see chapter 4.2.4.1 Documentaton = Output Measured s
Values). In the first column of the CSV-file, the measured values

are numbered ascending. The output of columns two to maximal ol ing. «. mustermann
three will be taken over by adjustment ‘Operating Mode ->
Adjust. Mode -> Measure Adjust.’ under the ‘Diagram’
headline. Here, each adjusted physical value will be written into

Measurement informations:

Sensor: SI-USB S5G Torgue
Sensortype: 2009

the file. The sequence: [X-Axis], [Y1- Axis], [Y2- Axis]. serial number; 123456
Caution: all output adjustments must be carried out ...l number (channely: 12345 B12345
before the measurement. prperonge vlue: — LOkNm
Caution: a CSV-file is a text file for the storage of  uncertainty of measurement: 0.01%
simply structured data. The abbreviation CSV stands R
Sampling rate: 2500/sec
for Character Separated Values or Comma  movingaverage: s12 128
Separated Values. These values are separated from  2Zrnele =en e e Ber e
each other by special delimiters, e.g. by a comma or  useradjustment: 09/25/2009 active
a semicolon. A CSV-file can be started by Excel® Start (Date Time):  09/28/2009 £:20:27 AM
through double-click (Windows Excel® 2007 - import
Vla data 9 "fr'0m teXt"). # Channel A (mV/V) Channel B (kN-m)
H H H H H H 0 0,000 mV/V -1,6384 kN-m
The@enotatlon pf I|st/f|eld/I|ne'-e:r}d|ng marks is not 110,000 w7V ek
explicitly determined. The definitions under 4.2.4.1 20,000 mv/v L6384 kN
. X -1, KN-
Documentation > Output Measured Values > ‘End P T e
of line character’ / 'Column separator’ / 'Decimal gg-gggmm LAk
. . . 3 m -1, -m
separator’ must possibly be adjusted in VASUSB or 70,000 mV/v 1,638 kN-m
in your spreadsheet. For this, see the manual of your 210,000 my/y L6284 kNm
9 0,000 mV/V -1,6384 kN-m
Spreadsheet. 10 0,000 mV/v -1,6384 kN-m

" Measurement: recording of a measured value series in the configured measuring rate of Start [...] to
Stop [...].
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4.1.2

File > Save Diagram (Shortcut ‘Ctrl+D’)

From here, measured data of the previous measurement7 can be stored in a BMP-file.
Predefined output variables can be adjusted in ‘Operating Mode 2> Adjust. Mode - Documentation’
under the ‘Output diagram’ heading in box ‘Memory size’. There are following possibilities:

max:

Adjustment is only available, if the running system recognizes two monitors. On these two
monitors, the diagram is maximum size stretched and stored.

normal:

The diagram is stretched to approx. screen size and stored.

min:

The diagram is stretched to approx. 800x600 pixel of the monitor and stored.

Window:

The diagram gets stored the way it was adjusted by the user.

Any measurement range can be selected by the range slider and the interval slider.

Diagram @
1> - Range slider
Channel A L.
[my/y] | Channel B

soon | - HmI
4000 2.0000
3,000 1.5000
2.000 1.0000
1.000 05000
OEEE 0.0000
; EEE -0.5000
sooo|  -hoooo \
4,000 -1.5000-12.25%. Ay 3
soo0 ! zoooo ¥

1.000 1.200 1.400 1600 1800 Time [sec]

> o i

- Interval slider

The diagram has a context menu. By right-click on the mouse key, following functions are available:

Zoom in:

The mouse pointer becomes cross-shaped. By pressing the left mouse key and moving the
mouse in the diagram, a rectangle appears which can be zoomed by releasing the mouse key.
Zoom out:

The diagram indicates the complete range of the previous measurement.

Scrolling:

The mouse pointer becomes cross-shaped with arrows. By holding the left mouse key in the
diagram, the curve can be shifted.

Grid on/off:

The dashed lines in the diagram form the grid. By this function, the dashed lines can be faded
in/out.

Show legend:
The legend indicates the physical variables and their units. By this function, it can be faded in/out.

Caution: When storing the diagram, only the currently presented part of the measurement will
be stored.
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4.1.3 File > Print (Shortcut ‘Ctrl+P’)

This function enables the print-out of the diagram with print time, configurable
heading, configurable remark, configurable address as well as a customized
logo (picture to the right).
The user can carry out the configuration by the navigation bar “documentation”®.
Line breaks in remark and address are converted into blanks.
Following restrictions are valid

e The heading is restricted to 20 characters

e The remark is restricted to 57 characters

e The address is restricted to 82 characters

In order to contain a customized logo, it must be stored under
the file name “Custom_Print_Logo.bmp* and copied to the folder
“%USERPROFILE%\AppData\LocaI\tecsis”g.

Caution: the recommended properties of the “BitMap ,,Custom_Print_Logo.bmp* are:
e Resolution: 160 pixel *160 pixel
e Maximum bit depth: 32bit

If there is no file named “Custom_Print_Logo.bmp* placed in the folder
“%USERPROFILE%\AppData\Local\tecsis®, the tecsis logo will be contained.

4.1.4 File - Exit (Shortcut ‘Ctrl+E’)

Closes the program. If the program is still in the measuring mode while closing, the measurement will be
ended. If automatic storage is adjusted (see chapter 4.2.4.1 Documentation - Output Measured Values
and chapter 4.2.4.2 Documentation > Output Diagram) it will be executed before the program is closed.

4.1.5 Operating Mode

This umbrella term contains all sensor-specific adjustments ‘Adjust. Mode’ as well as the
‘Meas./Diagram Mode’. By selecting a mode it will be displayed in the workspace. Following dialog
boxes can be displayed:
e Adjust. Mode - Sensor Connection (see chapter 4.2.1)
Adjust. Mode - Sensor Information (see chapter 4.2.2)
Adjust. Mode > Measure Adjust. (see chapter 4.2.3)
Adjust. Mode - Documentation (see chapter 4.2.4)
Adjust. Mode > Sensor Adjustment (see chapter 4.2.5)
Meas./Diagram Mode (see chapter 4.3)
When restarting the software it will start with the previous active dialog box. The next menu can be
entered via the shortcut ‘Ctrl+TAB’; the previous menu can be entered by ‘Ctrl+Shift+TAB’

® see chapter 4.2.4
® The environment variable %USERPROFILE% stores the current Windows® path of the
registered user.
This path is defined during the Windows® installation and can be changed in the system control and
through the group guidelines.
The user name is also included in the path...
As default, this path under Windows® 7 reads:
C:\Users\<Username>
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41.6 View

The control elements under ‘View’ are responsible for fade in/out of bars and displays as well as setting
back the windows view. In the menu/navigation bar a checkmark indicates faded in/out bars and displays.
The digital displays and the diagram can only be switched in the measuring and diagram mode, otherwise
they are grey (disabled). While executing ‘View 2> Reset Views’ (e. g. via the shortcut ‘Ctrl+R’) the digital
displays, the diagram and the main window are set back to original condition.

4.1.7 Language

Here, the language of the VASUSB can be adjusted.
All indications of the application are changed in accordance with the selected language.
Following languages are supported:

e German
e English
e French

At restart of the software, the previously adjusted language will show.

4.1.8 Help - Info

Here, the version number of the software is indicated.

4.1.9 Help > Advice

Contains the license conditions for this software, the address as well as the website and e-mail links.
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4.2 Configuration Mode

The configuration mode contains all of the sensor-, measurement- and documentation adjustments as
well as the output of sensor information. The adjustment dialog boxes are presented in the work space
through the menu/navigation bar. In the following chapters, the adjustments are introduced and the
functions are explained.

4.2.1 Sensor Connection

File Operating Mode View Language Help

Sensor Connection

‘( Interface Baud rate Address | Serial number Upper range value State Sensortype
Kommunikationsanschluss [COM1]  n.a. n.a. n.a. n.a. not available n.a.
PCI Communications Port [COM11] n.a. n.a. n.a. n.a. not available n.a.
PCI Communications Port [COM12] n.a. n.a. n.a. n.a. not available n.a.
Keyspan USB Serial Port [COM15] n.a. n.a. n.a. n.a. not available n.a.
Lorenz USB [COM18] 115,2k 1 20091 Current active LCV-USB
Lorenz USB [COM19] 230,4k 16 20092 Voltage available LCV-USB
Lorenz USB [COM21] 230,% 1 20093 10.0 kN available LCV-USB with digital input
Lorenz USB [COMS5] n.a. n.a. n.a. n.a. not supported DR-3000
Lorenz USB [COME6] n.a. n.a. n.a. n.a. not supported DR-3000

Update
Enables the configuration of different interfaces. Wed 11/25/2008 04:57 PM

This software exclusively supports tecsis devices of the type EZE21, EZE22and SI-RS485.
If a tecsis USB sensor is connected to a PC, it will be automatically activated by the VASUSB. The
VASUSB can only activate one sensor at a time. The selected sensor gets activated by double-click in
one of the displayed lines where the ‘State’ is shown as ‘available’. Sensors in columns with ‘State’ ‘not
available’ cannot be activated. ‘Not available’ means that the VASUSB could not open or activate the
interface, or that the sensor did not respond. If another process or application takes access on the
required interface, this access must be closed. Then search for free interfaces by the ‘Update’ key. The
status ‘not available’ indicates tecsis sensors which are not compatible with this software.

The list indicates further sensor information such as baud rate (115.2 or 230.4 kBaud), address, serial
number, final value of the measuring range and sensor type. The final value of the measuring range
indicates the actual nominal value of the channels or the interface type SG, Current, or Voltage. At the
two-channel SI-USB, the measuring ranges are presented separated with a virgule (channel A / channel
B).

The deactivation of a sensor occurs either by the activation of another sensor or by double-clicking on the
active sensor. When deactivating, the COM interface gets released and can be used by other
applications.
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4.2.1.1 Sensor Connection - Baud Rate

The baud rate can be switched between 115.2 kBaud and 230.4 kBaud by a click on column ‘Baud rate’

R e ST on the corresponding interface (see example on the
S e e left ‘Interface’ “tecsis USB [COM 13]%).
Sensor Connection
Interface Baudrate | Address | Se
Kommunikationsanschiuss [COM1]  n.a. n.a. n. Baudrate maximal adjustable Measurerate
Lorenz USB [COM10] n.a. n.a. i . .
PCI Communications Port [COM11] n.a. n.a. n in Baud single-channel co-channel
PCI Communications Port [COM12] ln.a. __na. N 115200 2500/s 1250/s
Lorenz USB  [COM13] 1152 |+ | 1 11
Lorenz USB [COM14] % 6 33 230400 5000/s 2500/s
Keyspan USB Serial Port [coM15]  [230,% 1 5, i
Lorenz USE [COM16] 230,4 1 22

@ The changed baud rate is constantly stored in the sensor. This adjustment is also valid for the
interplay with other applications.
@ The maximal adjustable sampling rate is depending on the adjusted baud rate and the used
processor of the PC.

4.2.1.2 Sensor Connection > Update

During this update all “tecsis USB” interfaces which are incorporated in the PC will be checked and read-
out. Herewith, the baud rate as well as the device address is detected and automatically adjusted.
Furthermore the complete sensor data and sensor information will be read-out. The course of the update
will be visually presented (see following image).

@ Caution: The state of SI-RS485 devices must be updated manually with the button “Update”

File Operating Mode View Language Help
Sensor Connection
Interface Baudrate | A... | Serialnum... | Upper ran... State Sensortype
Kommunikationsanschluss [COM1] n.a. n.a. n.a n.a. checkinterface n.a.
Lorenz USB [COM10] n.a. na. n.a. n.a. checkinterface n.a.
PCI Communications Port [COM11] n.a. n.a. na. n.a. checkinterface n.a.
PCI Communications Port [COM12] n.a. na. n.a. n.a. checkinterface n.a.
Lorenz USB [COM13] n.a. n.a. n.a. n.a. checkinterface n.a.
Lorenz USB [COM14] n.a. na. na. n.a. n.a.
Keyspan USB Serial Port [COM15] n.a. n.a. n.a. na | n.a.
Lorenz USB [COM16] n.a. n.a. n.a. na. | n.a.
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4.2.2 Sensor Information

File Operating Mode View Language Help
havigation Bar i Sensor Information

Common
Sensor (SI-USE: Force [ Voltage)

Sensortype: O 10 5
Serial number: 123458 Revision: 7

= _; Adjust. Mode
i--%% Sensor Connection
ﬁ Sensor Information
[ Measure Adjust,
[£] Documentation
£.%E Sensor Adjustment Adjustment created at:  10/16/2013 active™
@ Meas./Diagram Mode
_,.’ View
=, Digital Views

{:}- hannet 4

Factory adjustment

Adjustment created at:  10/16/2013 inactive

User adjustment

Channel A
Serial number Upper range value Accuracy dass Uncertainty of m.

A12345 120.0N 0.1% n.a

Liagfam Channel B

--[Z] Mavigation Bar Serial number Upper range value Accuracy dass Uncertainty of m,
e Bt B12345 Voltage 0.1% 0.0128 %
foie| Reset Wiews
_ Language
..M Deutsch
e English

-l Il Francais

_ Help

@ Info

L£D Advice

Ready for use. Senser connected Wed 10/16/2013 01:32 PM

h

This dialog box shows information and characteristics of the activated sensor. The VASUSB reads the
data during the sensor activation. If no sensor is activated, all indications are ‘n.a.’ (not available). If the
uncertainty of measurement shows ‘n.a.’ it means that the uncertainty of measurement is not stored in the
activated sensor. This value is determined in % from a tecsis proprietary calibration or a DKD calibration.
The detected value can be stored in the active sensor in menu ‘Sensor Adjustment’ under ‘Store
uncertainty of measurement in the sensor’.

tecsis sensors have two storage spaces for adjustment values, an unchangeable proprietary block and a
changeable user adjustment block. At user adjustment, the condition ‘active’ is also marked with *,in
case this adjustment uses the same factors as the proprietary adjustment. This is the case at subsequent
filing of the uncertainty of measurement at active proprietary adjustment.

4.2.2.1 Sensor Information > Common

This shows the general information of the connected sensor. Under the headline “Sensor” the sensor
designation EZE21, EZE220r SI-RS485 with indication of the sensor type (SG, Voltage, Current, Torque,
Force, ...) is listed in brackets, whereby channel A and channel B are separated by a virgule. Sensor
type, serial number, ID, Revision and proprietary calibration are non-modifiable default parameters.

4.2.2.2 Sensor Information 2 Channel A/B

These fields contain information of the respective measuring channel. In case of the EZE21, only channel
A is viewable and in case of EZE22or SI-RS485, channel A and channel B can be viewed. The serial
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number can be changed by the user in dialog box ‘Measure Adjust’ under Measured
variable->Display-> Serial number (see following chapter 4.2.3 Measurement Adjust.). tecsis GmbH
recommends entering the serial number of the connected sensor.

4.2.3 Measurement Adjust.

File Operating Mode View Language Help
Navigation Bar = Measure Adjust,
_ File Measured variable
@ 3a Type Low pass filter A Low pass filter B Sampling rate
E -U_' core el i-;_'!ChanneI A |;f Channel B | 1000 Hz vj | 1000 Hz - | | IEIO,ISEC - |
= Print
Exit Display
_ Operating Mode Decmal place Unit Average  Sign Scaling Serial number
A Made Channel A: [1 «| [n »|[s12 »|[+ »|[ change A12345
i | | a
= g ]
. Sensor Connection Channel B: |2 - |[crn] v| lZSE 'I |+ 'I | change | B12345
Sensor Information E—
2| Documentation
L %E Sensor Adjustment Diagram
@ Meas./Diagram Mode ¥-axis: | Time - | Reducing the sampling rate by averaging via 125  values,
Bl ¥1-axis:| Channel A v | V2-axis:|Channel B -
=+ Digital Views
L. Trigger
Start
Hletion SDUFCEi|5\ystemﬁmE vl 10/16/2013  13:33:52 (MM fddfyyyy HH:mm:ss)
{} LHagrarm " -
: Additional program to execute (full path): I
--[d Mavigation Bar kit (o) =
..[#] Status Bar Stop
../ Reset Views Source:|channn=JB leirecﬁon:lover run vlb'alue: 5 om
-/ taniguage Additional program to execute (full path): Iﬁ;l
.. Deutech prog path):
-.ofe English S
N Eroncas 10 MIO-validation
Firet Condition Second Condition
_J Help 7l
LT Info | i
XD Advice | Channel A - =
Loweer limit value Upper limit value Lower limit value Upper limit value
100 M 200 M M N
easurement adjustment (measured variable, diagram, trigger]. e 16, :
M dj ( d variable, diag igger) Wed 10/16/2013 01:52 PM

In this dialog box all measuring adjustments can be viewed and changed. The measurement adjustments
are subdivided into measured variable, diagram, trigger and OK/NOK-evaluation. Except for the serial
number, these adjustments will be accepted without confirmation.

The serial number field is secured by a query. The query appears after the first adjustment in the field.
The serial number is limited to maximal 6 digits. Possible characters are capital and lower case letters
from A-Z as well as numeracy from 0 to 9.

The adjustments in Measured variable>Type, Measured variable->Sampling rate, Measured
variable->Display and Measured variable->Diagram->Reducing the sampling rate by averaging via
X values are sensor related data and are saved in the sensor. Herewith an automatic configuration of the
software to the connected sensor is warranted.

When the application is finished, the previously not mentioned values are stored in the Windows registry
under the logged in user and restored after a restart of the software.

4.2.3.1 Measurement Adjustments - Measured variable > Type

This workspace is for the configuration of the measured variables which were recorded by VASUSB.
Before adjusting it must be decided which channels shall be collected. This adjustment is selected
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accordingly under Measured variable>Type. After switching, the control elements and their contents will
be adapted accordingly in Measured variable>Display, Measured variable>Diagram.

Caution: Selection of two channels is only possible if a tecsis device of type ’SI-USB’,
"SI-RS485’ or ’EZE21 with digital input’ is connected. At type ’EZE21’ channel A is a default
adjustment and cannot be changed.

4.2.3.2 Measure Adjust. > Measured variable - Low pass filter

@ Caution: This selection option is only available for ’SI-USB’

The integrated analog input filter is configured with this setting. The adjustment is made separately for
each measuring channel.
The following 3dB-frequencies are adjustable: 30 Hz, 300 Hz, 1000 Hz, 3000 Hz.

4.2.3.3 Measure Adjust. > Measured variable > Sampling Rate

Following measuring/sampling rates are adjustable: 5000/sec, 2500/sec, 1250/sec, 1000/sec, 500/sec,
250/sec, 200/sec, 185/sec, 100/sec, 50/sec, 33/sec, 25/ sec, 20/sec, 10/sec, 1/sec, 50/min, 20/ min, 10/
min, 1/ min.

The maximal adjustable sampling rate is depending on the adjusted baud rate and the PC system (see
chapter 7.2.1.1 sensor connection - baud rate).

4.2.3.4 Measure Adjust. > Measured variable > Display

The configuration view differs depending on the connected device. At the EZE21 only one channel will be
displayed and at EZE22two channels.

Display

Decimal place LInit Average  Sign Scaling Serial number
Channel A: |3 v| |[m1.-';"l.-'] v| |64 v| |+ v|| Change | A12345
Channel B: |4 v| |kN'm v| |512 v| |+ v| | Change | B12345

The adjustments under ‘Measured variable->Display’ determine the output and display of the respective
channel. Hereby, the number of decimal places, the unit, gliding averaging and the leading sign can be
selected and configured. Furthermore an own serial number can be assigned to each channel.

Up to four decimal places can be indicated for every physical size. This adjustment is considered in the
digital displays, in the diagram and in the readout of the CSV-file. For the adjustment of the unit of a
physical size, German, English and American units can be selected. The selection is dependent on the
type class of the connected device. The conversion onto the adjusted unit is automatically carried out by
the software. The under “Scaling” additionally defined unit is shown in square brackets. A gliding average
can be formed for each physical size of 1 to 512 values, with a grading in raster 2" of the adjusted
sampling rate. The leading sign of the channel is predefined in the sensor and through the adjustment
‘Measured variable->Display->Sign’ it can be changed.
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Key ‘Change’® under Scaling opens a dialog which allows scaling as well as the definition of an
additional unit. In the choice box ‘Measured variable> Display-> Unit’, the additional unit is marked with
square brackets.

Scaling Change [ )

Channel &

Sensor Adjustment

Force: 10.0 kN equate 25000 ADU
Scaling
Read actually 0.0 kN equate 12500 N
measvalue

| Change | | Cancel |

In dialog ‘Scaling Change’ the input variable (see previous image ‘Scaling Change’ under headline
‘Measure Adjust.’) can be scaled with an arbitrary unit. The ‘Sensor adjustment’ displays the defined
proprietary calibration and/or the user adjustment of the channel. In the image channel A with the input
variable force which reads out 25000 ADU at 10.0 kN nominal value was selected. A readjustment of
these values can carried out through the input boxes in Scaling. In the left input box either a certain force
value can be entered or the actual measured value of the sensor can be read. In the middle input box the
new output value which corresponds to the input value of the left box must be entered. In the right input
box a unit with a maximum length of 5 digits can be entered. By pressing key change10, these inputs will
be saved in the sensor.

Caution: The closer the scaling value to the final value of the sensor, the more precisely is the
display of the measured value during the measurement.

4.2.3.5 Measure Adjust. > Diagram

Diagram
¥-anis; | Time - | Reducing the sampling rate by averaging via 125  walues,
Y 1-axis: | Channel A - | Y 2-axis: | Channel B -

In input box ‘Reducing the sampling rate by averaging via X values.’ it is possible to decrease the
measuring points which should be saved by entering a value for X. Hence, the adjusted sampling rate
e.g. 200/sec at X=10 will be reduced to 20 displayed values in the diagram. This is also valid for storing
the measured values in a file. When reducing the sampling rate, an averaging over the last X values is
carried out.
The adjustment ‘Reducing the sampling rate by averaging via X values.’” has no effect on
the represented values in the digital displays.

@3 The adjustments under 4.2.3.4 Measure Adjust. > Measured variable - Display >
Average of the individual physical sizes and the adjustment ‘Reducing the sampling rate by
averaging via X values.” act cumulatively.

@ During the update of the diagram during an ongoing measurement, the complete
measurement is represented at a resultant sampling rate less than or equal to 20
measurements/sec. At sampling rates higher 20 measurements/sec, only the last 5
seconds of the measurement are represented. After the termination of the measurement,
the complete measurement is always shown in the diagram.

%1 no scaling was stored, ‘Create’ will appear instead of ‘Change’ and the selection in the unit box is
limited to the device type without an additional unit.
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The adjustment of this configuration should be started with the X-axis. Resulting from the adjustment of
the X-axis, the application updates the number of Y-axis as well as their selectable contents. All
combinations of measuring variables can be represented in a diagram.

@ Caution: The measured values are written in a CSV-file with the adjusted channels. The
writing sequence is: [X-axis], [Y1-Achse], [Y2-axis]. If a Y-axis is not required, it is also possible
to set them to “Off”. Nevertheless, the application assures that minimum one variable on the

Y-axis has not been set to “Off”.
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4.2.3.6 Measure Adjust. > Trigger

Course:
7. Select a start event.
8. Select a stop event.
9. Enter trigger key.
10. Actuate a trigger start event.
11. Actuate a trigger stop event.
12. Measurement recorded.

Initial state
.| Measure OFF

| Trigger OFF
Trigger O |grey

— 41

Trigger pressed?
No

Yes

\ 4

Measure OFF
Trigger ON

T | 307 yellow flash
LA

»

(T )

Triggerstart event fulfilled?
OR
Measure Start pressed?

\4
[ Measure  ON

| Trigger ON
Trigger @ |green

No

Yes

Triggerstop event fulfilled?
OR

No Measure Stop pressed?

Yes
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In the previous signal flowchart, the general course of measurement by means of a triggering is

described. The

activation button ‘Trigger’ can be found in the ‘Meas./Diagram Mode’ under ‘Measure

Stop’. The software triggering consists of two events which are adjustable according the requirements as

follows:

e Trigger start > Source:

(o]

Off/Measure Start:
Entering ‘Measure Start’ releases the Trigger start event. (The function to start an event

can also be entered in the following sources).
Channel A / Channel B:

See chapter 4.2.3.6.1 Trigger. Toger
System time: Source:| Systemtime | 10/16/2013  13:33:52 (MM/fdd/yyyy HH:mm:ss)
The appllcatlon ShOWS an |npUt bOX Additional program to execute (full path): @

where the date and the time of the

measurement start can be adjusted. The adjustment is limited to the current time plus 15
seconds. These values must be re-adjusted after each measurement; otherwise the
following measurement will start immediately by pressing the trigger, because the
previously adjusted time lies in the past.

e Trigger stop = Source:

(o]

Off/Measure Stop:

Entering ‘Measure Stop’ releases the Trigger stop event. (The function to stop an event
can also be entered in the following

sources) Sslzrpca:|channe\3 '|D\rechan:|0verrun v‘Va\uE: 5
Channel A / Channel B:

See chapter 4.2.3.6.1 Trigger.
Measurement duration:

For this selection an input box is available. The time unit (seconds, minutes) is taken from
the sampling rate. The number of measurements is calculated and displayed by the
application next to the input box.

Number of measurements:

For this selection, an input box is available to indicate the number of measuring points.
The measurement duration is displayed and calculated next to the input box. The time
unit (seconds, minutes) is taken from the sampling rate.

Additional program to execute (ful path): @

@ Remark: The source adjustments of trigger start and trigger stop can be optionally combined
with each other.
@ Remark: The adjustments “Measurement duration” and “Number of measurements” refer to
the adjusted sampling rate and not to the reduction of the sampling rate.

After executing Start/Stop: Two trigger events can be assigned actions through these fields.
After the event occurrence and/or evaluation and storage actions, the program specified in this field will

be executed.

Any executable files and batch files are admissible. These files can be manually specified with full path or
selected via requester through the folder icon.
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4.2.3.6.1  Trigger

The picture on the following page shows an o=

Start

example Of hOW a measurement by means Of Source:| Systemtime | 10/16/2013  13:33:52 {MMjddfyyyy HH:mm:ss)
triggering can be recorded to a physical variable. At

. . Additional program to execute (full path): @
excess, the hysteresis value will be deducted from =
the threshold and at under-run it will be added. The  sourcs{chanels = |pirecton:[overrn =] value: 5] am
hysteresis calculation for each possible physical N &

size is shown under the example diagram on the
next page. At this triggering not only the value of threshold (Yoer; Zover) Of @ physical variable, but also a
direction must be indicated. In the example diagram, the direction ‘over run’ is triggered. This means that
the measured value must drop below the hysteresis value first, before the trigger is responsive to the
exceeding of the threshold. In contrast, the setting “drop below” means that the measured value must rise
over the hysteresis value before the trigger is responsive to dropping below the threshold value. The grey
boxed area of the example diagram corresponds to the display in the diagram of the VASUSB after the
measurement. This area can be saved in a CSV-file.

e Y. = Trigger start value of a physical variable with directional adjustment ‘over run’

o Z,e = Trigger stop value of a physical variable with directional adjustment ‘under run’
At over run, the value of the hysteresis is deducted from the value of threshold; when below, it will be
added. The calculation of hysteresis for each possible physical variable is shown beneath the example
diagram on the next page.

4.2.3.6.2 Example Diagram

[Channel A/ ChannelB ... ..cooveeivniennns
A ] E
Y over E 1 Hysteresis
- e N\ .
= Triggerstart -
: event E
: >t
Triggerstop -
] event  : /
Zover -/ Hysteresis
: =

4.2.3.6.3 Hysteresis

The size of the hysteresis is 1% of the indicated nominal value of the connected sensor. Except for type
classes SG, Current and Voltage the hysteresis will be scaled to maximal 1% of the input value because
the nominal value is usually not known.

4.2.3.7 Measurement Adjustments - OK/NOK Evaluation

These settings affect the evaluation of a measurement series. After a 15 o-yaiidation
trigger stop event occurs, the max. values of these measurement First Condition

series are determined and compared with the stored limits. In order v
to obtain an OK-display, the max. value of a measurement series Channel A -
must be above the lower and below the upper limit. Lowerimitvalue  Upper limit value

If two conditions are defined, both conditions must meet the OK w0 |n 20 |n

criteria for a total OK-display.
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4.2.4 Documentation
File Operating Mode View Language Help
Mavigation Bar x Documentation
. File
Qutput measured values End of line character:
Save Diagra Automatic storage: ISave all measurements into one file vl I[CR.I.F} vl
e Pr!nt Target directory: aldDocumentsivs2 (3] Prefix: TAB Column separator:
Exit R R
__ Operating Mode Output measured values IJ' 'l
=k _+ Adjust. Mode Automatic storage: |Save all measurements into one file vl Dedmal separator:
> . e
%% Sensor Connection . : —————— M
: Target directory: [g : -
% Sensor Information - Bk i ﬂ prefix: ERG .
[H] Measure Adjust. Additional infarmation show hide
8] Documentation [T Headline [ 7| Uncertainty of measurement [¥] Date [ Time
L5 Sensor Adjustment [Pl Address [ | Comment [¥] Physical unit
-.[B] Meas./Diagram Made
i View
= Qutput diagram
Automatic storage: ISave any diagram with an own index T |
dation Target directory: Ci\UsersVrappold'\De 1:24 Prefix: DGM
R Memory size: [normal =
.-[#] Navigation Bar |4]
-.[#] Status Bar — . .
) Reset Views Additional information
e Headline
_+ Language
. Deutsch Measure - Measure K25
L% =
e English Address Comment
Francais
L Lorenz Messtechnik GmbH Dipl. Ing. K. Mustermann
! Help CObere Schlossstrafie 131
@ Info 73553 Alfdorf
@ Advice Deutschland
Ready for use. Sensor connected Wed 10/16/2013 02:04 PM

he

Here, the user can carry out documentation configuration. The adjustments refer to the storage of
measurements as BMP and/or CSV-file.

4.2.4.1 Documentation = Output Measured Values

e Automatic storage:
The storage of the measured value into an output file can occur automatically by the software.
Three adjustment possibilities can be selected:

o None: The automatic storage is disabled.

o Save all measurements into one file: This option files each measurement in the same
CSV-file at the end. The name from the prefix field is used as the file name. The file is
saved in the registered target directory.

o Save each measurement with its own index: This option creates a separate CSV-file
at the end of each measurement. The file nhame consists of the prefix and the index
YYYYMMDDHHmmss##HH (‘###H# number beginning with leading zeros 0000; 0001; ...)

@ The path length is limited by the operating system.

@ Remark: Definition “Measurement” see chapter 4.1.1File - Save Measvalue
(Shortcut ‘Ctrl+M’).
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e Target directory: Scarch folder =
The target path is entered in ‘Target directory’ (Standard adjustment Please select 2 fider from th it

...\<user name>\My documents\VASUSB). Likewise you can click on

Offentlich

the folder and select a directory. Wemds)
o Prefix: ZHP,RECGVERV(D:) ‘ 3
Please enter the file name which is used for the automatic storage in i T
this input box. (Further details about file name/prefix can be found e B
under headline “Automatic Storage”. Kicken Se auf dos Syl neben cinem Oncer,um

Unterordner anzuzeigen,

Newen Ordner erstellen o Abbrechen

4.2.4.2 Documentation 2 Output Diagram

Automatic storage:
The software can automatically save the diagram in an output file. For this, two adjustment
possibilities are available:
o None: the automatic storage is disabled.
o Save any diagram with an own index: this option creates a separate BMP-file at the
end of each measurement. The file name is a combination of the prefix and the index
YYYYMMTTHHmmss##HE (‘#HH#H# number beginning with leading zeros 0000; 0001; ...).

@ The path length is limited by the running system.
@ Remark: Definition “Measurement” see chapter 6.1.2 File > Save Diagram (Shortcut

‘Ctrl+D’)...
. Search folder ===
b Tarqet dlreCtorv: Please select 5 folder from the fist:
The target path is registered in ‘Target directory’ (standard adjustment
..\<user name>\my documents\VASUSB). Instead of this, you can | |, %=
click on the folder and select a directory. &L Lotater Dotentrager (€
= HP_RECOVERY (D:)
‘_,,iOSjOOLS(E:) )
o Prefix: e
Enter the file name which shall be used for the automatic storage in M“““ﬁ“‘“‘“’fi‘f ) =
this input box (further details regarding file name/prefix can be found | e smasgen ‘
under the headline ‘Automatic storage’). (b et pesss

4.2.4.3 Common Settings Output Values and Output OK/NOK-Evaluation

e End of line character:
The desired line ending mark for the output in a file gets adjusted in this box.
Following possibilities can be selected:
CRLF : Carriage Return / Line Feed Carriage return line feed (MS-DOS, Windows)

LFCR : Line Feed/ Carriage Return Line feed carriage return (Linux Console)
CR : Carriage Return Carriage return (Apple I, Apple Mac OS up to Version 9)
LF : Line Feed Line feed (Unix-Derivate, Mac OS X)

e Column separator:
The column delimiter will be read out at the first execution of the application from Windows

system control (country selection) and will be set accordingly. At each further restart of the
application, the previously adjusted delimiter will be used. Following selection is possible in this

box:

TAB : Tabulator
; : Semicolon
, : Comma

. : Point
Space : Space character
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o Decimal separator:
The decimal delimiter is carried out the same way as described for the column separator.
Following selection is possible in this box:
, : Comma
: Point
Remark: Supplementary changes of the country adjustments in the operating system have no
influence on the once adjusted values of this software.

o Additional information show / hide:
In this group, checkmarks can be placed to add further information to the output of measured
values. The entries in the three entry boxes ‘Headline’, ‘Address’ and ‘Comment’ can be
specified arbitrarily. With the checkmark, these entries will be recorded in the output file. The
‘Uncertainty of measurement’ - if the connected sensor has one - can also be displayed in the
output file. By a checkmark in ‘Date / Time’ the measurement period can also be recorded in the
output file. By a checkmark in ‘Physical unit’ it is also possible to systematically fade in/out the
physical units in the output file.

¢ Memory Size:
See chapter 6.1.2 File > Save Diagram ‘max’, ‘normal’, ‘min’ and ‘window’.

4.2.4.4 Documentation - Additional Information

This is free text which can be activated in ‘Documentation = Output measured values - Additional
information show / hide’.

4.2.5 Sensor Adjustment

File Operating Mode View Language Help

Mawvigation Bar # Sensor Adjustment

_ File

e Save Measvalue

I Szve Diagram

& Print

fi) Exit

_+ Operating Mode

L Adjust, Made

_§) Sensor Connection

L% Sensor Information

[M] Measure Adjust,

; Documentation
Laxg Sensor Adjustment

-.[®] Meas./Diagram Mode

i View

- Digital Views
{f} Channel 4

{:} Channel B

{:} G/ NIC-calidation

{:} :'_::;-_;_.r,a,n

.[7] Mavigation Bar

...[7] Status Bar

-..[T| Reset Views

_+ Language

..M Neutsch

-l English

-0 B Francais

— Help

LD Info

LD Advice

Ready for use, Senser connected Wed 10/16/2013 02:06 PM
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In this dialog, the uncertainty of measurement in % can be stored in the connected sensor. This variable -
if available - shows the application in the ‘Meas./Diagram Mode’ and in the ‘Sensor Information’ dialog.
The uncertainty of measurement can also be read out in a CSV output file (see chapter 4.2.4.1
Documentation = Output Measured Values).

e Store uncertainty of measurement in the sensor:

This function allows storing a maximum value for the uncertainty of measurement in the sensor.
This value is usually determined at a proprietary or DKD calibration. If the proprietary adjustment
of the connected sensor is active and if a value for the uncertainty of measurement was indicated,
it means that the sensor had a proprietary or a DKD calibration at tecsis GmbH.

Permissible values for the uncertainty of measurement are [5 % > uncertainty of measurement >
0 %]. If the sensor is connected, this value will be displayed in the ‘Meas./Diagram Mode’, in the
"Sensor Information’ and if required in the CSV-output file. This value is only for documentation
purposes and has no influence on the measured values.
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4.3 Meas./Diagram Mode

@ Caution: During a measurement it is not allowed to interrupt the data
connection to the PC !

File Operating Mode View Language Help

_Na\rigaﬁun Bar x Meas. /Diagram Mode Channel 4 Display x
_+ File
----- & Save Measvalue : Measure Start | -1 _5 N
----- & save Diagram
_____ & print [ Messure ston oy 5N 134N
_+ Operating Mode O Trigger auto repeat
£ _¢ Adjust. Mode
... %% Sensor Connection - e ——
@ 024 cm
00 cm Qi om 4645 om
(B Meas./Diagram Mode TRRE Wy Rssst 184 Riesst
o View
=) Digikai.‘l."ims Sampling rate: 1250fzec
..[Z) Channel A
..... Channel B Serial number: 123458 IO - Validation Display (First Condition) =
_____ 10/NIO-validation Upper range value { A (B ): 120,0 N [ Voltage
: Uncertainty of measurement (8 ); 0.0128 %
Diagram
- Mavigation Bar
----- Status Bar
----- /o Reset Views
_+ Language
.. Deutsch
..af= English
----- B 0 Francais
4 Help
@ Info
@ Advice
x
| 1
Channel A% =
;| Channel B; : ; : : : :
ot I L) S S S SRS S S S
zo0|
RN pl e R
soo|
a0
20.0°
00
200 ot ke T R e A e 3 }
= 3 0 . 1.500 2,000 2800 3,000 3500 4,000 4500 5.000 Time ['sec]l
o
8| [ 14
a
Ready for use, Sensor connected Wed 10/16/2013  02:09 PM

In the ‘Meas./Diagram Mode’ the digital displays of the physical variables and the diagram can be
activated. Only the displays which were check-marked in ‘Measure Adjust. > Measured variable > Type’
are active.

Each, the digital displays and the diagram are in an independent window. These windows can be
positioned to the main window or they can freely be placed on the monitor. In order to scroll the windows,
the mouse pointer must be placed on the title bar of the respective window. By keeping the left mouse
key pressed, the window can be shifted or positioned. The contents of the window automatically adapts to
the window size. By key ‘Ctrl’ the positioning in the main window can be avoided.
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Due to system-relevant restrictions under operating systems Windows 2000 and Windows XP it is not
possible to draw the diagram out of the main window of the application. Also, with these operating
systems, the application cannot be placed outside of the monitor. When trying, it will always go back to
the visible workspace.

Each digital display has four output fields for the current measured value, the tare value, the minimum
value and the maximum value. The minimum and maximum value can be set back by the buttons ‘MIN
Reset’ and ‘MAX Reset’. If the tare-button shows 'TARE’ and is kept pressed, this will set the current
measured value to zero and the tare difference will be displayed above in the output field. Afterwards this
button shows ‘TARA=0’, hereby the tare can be cancelled.

The OK/NOK display always shows the total of all defined criteria. If the criteria is met, a green indicator
appears. If at least one criterion is not met, the indicator turns red. A grey indicator means that there is
currently no evaluation, e.g. after start-up or after a new series of measurements was started.

Measure Start:
With this button, a measurement gets started. The digital displays and the diagram will be fed with
measured values after pressing this button. Unnecessary keys are deactivated during the measurement.
Also, the status of the application “Measuring...” is indicated in the status bar.

= Software trigger start event

Measure Stop:
Can only be used during active measurement. As soon as the key was pressed, the measurement will be

stopped and will initiate possible automatic storage (see chapter 4.2.4 Documentation). At active
automatic storage into a file, the progress is shown on the status bar as well as the idle state ‘Ready for
use. Sensor connected’.

= Software trigger stop event

Trigger:

This key activates a software triggering as explained in chapter 4.2.3.6.1 Trigger. The status lamp on the
side of the key blinks yellow at active triggering. By pressing again, the triggering will be deactivated. The
course of a software trigger is described in chapter 4.2.3.6 Measure Adjust. > Trigger

Trigger LED  Condition

grey Trigger OFF
flashing Trigger waits for a trigger start event.
yellow Only the digital displays are updated.
Trigger Measurement ON. Digital
green displays and diagram are updated with
values.

Trigger Auto Repeat:
By a check mark, the trigger gets reactivated as soon as all actions of the Trigger-Stop-Event are

processed (e.g. write file. See chapter 4.2.4.1 Documentation - Output Measured Values and chapter
4.2.4.2 Documentation > Output Diagram)

@ Activate only if an automatic storage from 4.2.4.1 or 4.2.4.2 is active.

Single Measurement:
With this key, a single current measured value gets requested from the active sensor. This function can
only be carried out in the idle mode/measuring stop of the application.

Control:

The button ‘Control’ is only activated during the measurement at low sampling rates (<20/sec) and in idle
mode.

By means of the control, the measuring bridge in the sensor gets detuned and issues the nominal range.
A red lamp next to the button indicates active control. By clicking on ‘Control’ again, it will be deactivated.
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5 Debugging

This chart helps to find frequent errors and the measures for debugging.

Error Possible Cause

Debugging

Application does not start WIN98 or older versions are used

Required operating system:
WIN 2000; WIN XP; WIN VISTA,
WIN 7, WIN 8

No drivers for USB sensors

Install the driver packet from the
product CD. Install drivers with
administrator rights, only.

Sensor is not connected to the PC

Connect sensor to the PC

Sensor is connected to the PC | Driver problems or misconduct of the
but the application won’t start | USB connection

or communication not
available.

Terminate the application. Unplug
the USB-connection between
sensor and PC and reconnect it.
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